Important Notices

The material contained in this publication (including any supplementary information) constitutes and contains confidential and proprietary information of Infor.

By gaining access to the attached, you acknowledge and agree that the material (including any modification, translation or adaptation of the material) and all copyright, trade secrets and all other right, title and interest therein, are the sole property of Infor and that you shall not gain right, title or interest in the material (including any modification, translation or adaptation of the material) by virtue of your review thereof other than the non-exclusive right to use the material solely in connection with and the furtherance of your license and use of software made available to your company from Infor pursuant to a separate agreement ("Purpose").

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to maintain such material in strict confidence and that your use of such material is limited to the Purpose described above.

Although Infor has taken due care to ensure that the material included in this publication is accurate and complete, Infor cannot warrant that the information contained in this publication is complete, does not contain typographical or other errors, or will meet your specific requirements. As such, Infor does not assume and hereby disclaims all liability, consequential or otherwise, for any loss or damage to any person or entity which is caused by or relates to errors or omissions in this publication (including any supplementary information), whether such errors or omissions result from negligence, accident or any other cause.

Trademark Acknowledgements

All other company, product, trade or service names referenced may be registered trademarks or trademarks of their respective owners.

Publication Information

Release: Infor ERP SyteLine 8.02
Publication Date: Friday, April 29, 2011, 2:54 pm
# Contents

## Preface
- Document Availability ............................................. 7
- Online Help .......................................................... 7
- Infor ERP SyteLine Document Set ................................. 8
- What You Should Know .............................................. 9
- Contacting Infor ...................................................... 10
- Planning Your Communication .................................... 10
- Signing Up for Support ............................................. 11

## System Architecture .................................................. 13
- SQL Server ............................................................ 14
  - Application Database ............................................. 14
  - Forms Database .................................................. 14
  - Objects Database ................................................ 15
- Client ................................................................. 15
- COM+ ................................................................. 16
  - Intelligent Data Objects (IDO) ................................. 16
- Windows Terminal Server .......................................... 17

## Infor Framework TaskMan and Background Tasks ............... 19
- Overview ............................................................. 19
- Setup During Installation .......................................... 20
- Setup After Installation ............................................ 21
  - Configure Printers ............................................... 21
  - Define Report/TaskMan Settings on the Intranets Form .... 21
  - Define E-mail Addresses if Required .......................... 22
  - Define Report Options ........................................... 22
  - Define Excluded Tasks .......................................... 22
- Managing Background Tasks ........................................ 23
  - Schedule Reports and Utilities to Run in the Background ... 23
  - Check Which Background Tasks are Running ................. 23
  - View Background Tasks That Have Run ....................... 24
  - Create a Background Task ...................................... 24
  - Store Options .................................................... 25
  - Get Options ....................................................... 25
## Contents

- Options Defaults .......................................................... 25
- Troubleshooting ............................................................ 26
  - Event Messages from TaskMan ....................................... 27
  - TaskMan Debug Mode .................................................. 29
  - TaskMan Debug Mode Messages .................................... 30
- Use SQL Profiler to Trace TaskMan Instances ...................... 38
- Stored Procedures Used for Performance Benefit .................. 38

## License Management .................................................... 39
- Types of Users ............................................................ 39
- License Document ........................................................ 39
- License Management Form .............................................. 40
  - Apply A License ......................................................... 41
  - Post License Application Steps .................................... 41
  - Multi-Session Users .................................................. 43
- Licensed Modules Form .................................................. 44
- User Modules Form ....................................................... 44
  - Multiple Logins ....................................................... 45
  - Recover Locked Tokens .............................................. 46

## Multi-Site ........................................................................ 47

## Authorizations .............................................................. 49
- Object Authorizations For User ....................................... 49
- Object Authorization for Group ....................................... 50
- Users .......................................................................... 51
- Groups ........................................................................ 52
- Create a Super User ....................................................... 53
- Assign a User to a Group ............................................... 53
- Assign a User to a Primary Group ................................... 53
- View Group Authorizations ............................................ 54
- Edit Authorizations for a User in a Group ......................... 54
- Change Passwords .......................................................... 55
- Copy User Tables .......................................................... 55
  - Requirements ................................................................ 55
- Group Lists .................................................................... 58
Recovering After a System Crash .................................................. 145
  Crash Recovery Utility ......................................................... 145
  Unlock Locked Functions ...................................................... 146
  Unlock Locked Journals ........................................................ 147
  Recover Locked Tokens ........................................................ 148

Setting up an Audit Log .......................................................... 149
  Process Defaults ................................................................ 149
  Audit Log Types .................................................................. 150
  Audit Log ........................................................................... 151

Improving Performance ............................................................ 153
  Hardware ............................................................................ 153
  SQL Server Settings ............................................................ 153
  Unneeded Data .................................................................... 154
    Purge or Compress Unneeded Data .................................... 154
    Examine Table Size .......................................................... 155
    Filter Inactive Records in Data Integration ....................... 157
  SQL Server Maintenance ..................................................... 157
    Statistical Information ........................................................ 157
    Update Statistics ................................................................ 158
    Fragmentation Information ................................................. 158
    Defragment Indexes ........................................................... 159
  Customizations .................................................................... 161
  User Actions ......................................................................... 161
    Reduce the Number of Rows Returned in Queries ............. 162
    Reduce the Scope of Reports ................................................. 162
  Replication .......................................................................... 162
  Locking and Blocking .......................................................... 162
    Monitor Blocking ............................................................... 163
    Save Each Modified Row in a Separate Transaction .......... 163
    Set the Collection Read Mode (Transaction Isolation Level) 164
    Prevent Locking of the Journal Table During Mass Journal Posting 164
    Prevent Blocking of Other Processes When Rolling Current Costs to Standard Costs 164
    Prevent Deadlocks on the Item Table During Certain Operations 165
    Avoid Long Delays from Deadlocks .................................... 165
  Windows Tools .................................................................... 165
  SQL Server Stored Procedures and Commands .................... 165
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshoot Timeout Errors</td>
<td>165</td>
</tr>
<tr>
<td>Populating An Empty Database</td>
<td>167</td>
</tr>
<tr>
<td>Database Name Change</td>
<td>171</td>
</tr>
<tr>
<td>Web Rendering Differences</td>
<td>173</td>
</tr>
<tr>
<td>- Runtime Options</td>
<td>173</td>
</tr>
<tr>
<td>- From the Form menu</td>
<td>173</td>
</tr>
<tr>
<td>- From the Actions menu</td>
<td>173</td>
</tr>
<tr>
<td>- From the View menu</td>
<td>173</td>
</tr>
<tr>
<td>- Window menu</td>
<td>174</td>
</tr>
<tr>
<td>- Non-supported items</td>
<td>174</td>
</tr>
<tr>
<td>- Items supported beginning with version 8.02.11.</td>
<td>174</td>
</tr>
<tr>
<td>- Form Component Types</td>
<td>175</td>
</tr>
<tr>
<td>- UserControl</td>
<td>175</td>
</tr>
<tr>
<td>- WinStudio Diagnostics</td>
<td>175</td>
</tr>
<tr>
<td>- Event Handler Response Types</td>
<td>175</td>
</tr>
<tr>
<td>- Opening a Second Session in Internet Explorer</td>
<td>176</td>
</tr>
<tr>
<td>- Other Non-Supported Items</td>
<td>176</td>
</tr>
<tr>
<td>- SytePlan</td>
<td>176</td>
</tr>
<tr>
<td>- Forecasting</td>
<td>176</td>
</tr>
<tr>
<td>- Workbench Suite</td>
<td>177</td>
</tr>
<tr>
<td>- FS-Plus</td>
<td>177</td>
</tr>
<tr>
<td>- Web.config Settings for the Web Client.</td>
<td>179</td>
</tr>
</tbody>
</table>
Preface

The *Infor ERP SyteLine System Administration Guide* contains background or supplemental information to answer questions you may encounter as you manage and maintain Infor ERP SyteLine. Infor ERP SyteLine offers you, as System Administrator, considerable power to manage the system and its users in accordance with good business practices and company policy.

This manual is intended as a reference. For instructions on how to install the Infor ERP SyteLine system, see the *Infor ERP SyteLine Installation Guide*. For information about using the Infor ERP SyteLine system, see the Infor ERP SyteLine online help. Consult this manual when you have questions about Infor ERP SyteLine design or architecture.

Document Availability

The most current version of all documentation is available on the Infor web site at http://www.infor365.com. You will be able to get all kinds of online support here including phone numbers, documentation, and more.

To access this area, you need a password, which Infor provides.

Online Help

Infor ERP SyteLine online help gives you instant access to procedures and information about forms and fields. You can access Help from Infor ERP SyteLine forms, from other topics within Help, or from the search (index) function. Select Help>Contents and Index from the Infor ERP SyteLine title bar to open the Help, or use the F1 key to get help on any form or field.

Developer-Level Help

To access the help for developers, select Help>Customizing Forms.
Infor ERP SyteLine Document Set

The *Infor ERP SyteLine Installation Guide* describes how to install Infor ERP SyteLine and how to upgrade from SyteLine 5 or 6 to Infor ERP SyteLine. If you need to upgrade from a version earlier than version 5, upgrade to SyteLine 6 first. Follow the steps to upgrade from an earlier version of SyteLine to SyteLine 6 found in the *Getting Started* manual for SyteLine 6. You can download this manual from Infor's web site at http://www.infor365.com.

This *Infor ERP SyteLine System Administration Guide* supports you in your ongoing responsibilities to provide a high level of service to various users, including how to:

**Add and remove users**
- Determine user status and the appropriate level of system access
- Determine user names and place them in the file system hierarchy
- Disable users who should no longer have system access

**Perform backups**
- Ensure backups are executed correctly and on schedule and the status is recorded
- Perform incremental and full system backups
- Test system backups periodically for data integrity

**Assist users**
- Answer user questions about the system
- Help users access software to accomplish tasks for which they are responsible
- Modify system parameters based on user or business needs

**Recover after a system crash**
- Recover Locked Tokens
- Unlock locked functions
- Unlock locked journals

**Manage background processes**
- Schedule Reports and Utilities to Run in the Background
- Check Which Background Tasks are Running
- Delete a Waiting task
- View Background Tasks That Have Run
- Create a Background Task
- Store Options
- Get Options
- View Options Defaults
- Understand Task Manager
What You Should Know

System Administrator

In order to keep your system running smoothly and to solve problems you might encounter, you should understand how to do certain typical system administration tasks. If you do not have the knowledge outlined below, please complete the necessary training before you try to administer your system.

General Knowledge

You should be able to:

- Develop strategies for recovering data when failures occur
- Understand basic network concepts such as protocols, workstations, servers, LANs, network cards, hubs, routers, and WAN connectivity
- Understand benefits/drawbacks to hardware or software disk fault tolerance
- Configure and troubleshoot TCP/IP: HOSTS, SERVICES, ping, and DNS
- Understand and configure TCP/IP services: WINS and DHCP
- Monitor and troubleshoot networks
- Configure and troubleshoot PCs
- Have advanced Windows skills, including creation of icons/shortcuts, add/changing device drivers, use and editing of AUTOEXEC.BAT, and mapping drives
- Troubleshoot Windows/Application DLL conflicts
- Understand basic Microsoft network functions and terminology such as user accounts, group accounts, and shared resources
- Install and configure Windows Operating System
- Understand the difference between Workgroup and Domain models
- Understand the differences and benefits of FAT vs. NTFS
- Troubleshoot performance and measure resource demand
- Properly use and configure shared resources: DISK and PRINTER.

SQL Server

NOTE: This manual contains no information on how to work with SQL Server. Contact your Microsoft SQL Server documentation for help on how to do this.

Some of your Infor products, including Infor ERP SyteLine, include the use of SQL Server. You should be able to perform these daily and weekly tasks to maintain the data on the server:

- Understand the use and purpose of a database, transaction log, and device
- Install and configure SQL server for optimal use
- Modify the configuration to accommodate changing user and data requirements
- Monitor space usage
- Create database and backup devices
Backup/restore a database
Change the size of devices and databases
Schedule tasks to occur automatically at a specified time
Use monitoring techniques to assess the performance of SQL Server
Use DBCC commands
Understand the role and purpose of the Master, MSDB, and TempDB Databases
Document the database creation sequence
Update database statistics
Recover in the event of a system or media failure
Use ISQL/w and SQL command syntax proficiently.

System Users
You should be able to use your workstation to perform tasks such as opening and closing applications, selecting items from menus and lists, and using standard Windows objects.

Contacting Infor
To contact Infor support, go to www.infor365.com.

If we update this document after the product release, we will post the new version on Infor365. We recommend that you check this Web site periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.

Planning Your Communication

To make sure the correct analyst is assigned to your case and to expedite the resolution of your questions, please have the following information available when you call us:

- Your company name and phone number
- Infor ERP SyteLine version release and point release
- Database software version and release, if applicable
- Platform or environment (Example: Windows 2003)
- Functional area (Examples: Production, Administration, etc.)
- What you were doing (Example: Printing a report)
- What type of data you were accessing or trying to access (Example: Customer data)
- If you received an error message, the full message text and error number
- If you are calling back on an existing case, the case number
Signing Up for Support

If you are not currently on support and would like more information on your support options, please call your customer account representative. If you are not sure who your account representative is, contact Infor Customer Service.
This chapter provides an overview of the Infor ERP SyteLine architecture and tells you where specific pieces of the system are located.

Below is a diagram of the architecture.

NOTE: The above diagram applies to environments with multiple web servers. In environments with just one web server (the utility server typically serves as a web server), only "Web Server x" would be used.
SQL Server

Microsoft SQL Server is responsible for things such as:

- Maintaining the relationships between data in the database
- Ensuring that data is stored correctly and that the rules defining data relationships are not violated
- Managing data and user security
- Optimizing server function performance
- Recovering all data to a point of known consistency in case of system failures.

SQL Server is primarily responsible for managing databases that interact with enterprise business systems. Some of the components that make up these databases are:

- Tables
- Views
- Stored Procedures
- Triggers
- Constraints
- Indexes
- Keys
- User Defined Data Types.

Application Database

The application database is one of the three main databases (the forms database and the objects database are the others) that comprise the “back-end” of Infor ERP SyteLine. The application database holds all of the application data for Infor ERP SyteLine, such as customer, item, customer order, etc. It is made up of hundreds of tables, stored procedures, triggers, user defined data types, and indexes. This information is stored on the database server.

Forms Database

The forms database holds all of the information about each form in Infor ERP SyteLine. This information is stored on the database server.
For example, in the Items form shown below, components such as text boxes, labels, tabs, radio groups, buttons, and all of the associated properties (such as size, color, validation, events) are kept in the forms database in a multitude of tables.

Objects Database

The objects database stores the IDO metadata.

Client

The client is where the user interacts with the application data and can customize forms.

End-User or Admin Client

Clients connect to the utility server
COM+

NOTE: COM+ is used by APS.

COM+ is a server engine designed to make COM-based applications extremely scalable. It allows many users to share connections to the same database without degrading performance.

Intelligent Data Objects (IDO)s

Intelligent Data Objects are one of the key pieces of technology that bring the client layer and the data layer together. They are components of code that represent associated units of information and logic that are called from the client layer and interact with the data on the database.

Within the system's architecture, the client application never talks directly to the database. The client forms communicate to the Application Database through a “middle-layer” in which it calls an IDO to do the querying, saving or changing of data. Each form has an associated IDO behind the scenes to work with the application database.
Windows Terminal Server

The optional Terminal Server is a multi-user Windows application server. Terminal Server supports enterprise wide application deployment using a thin client architecture. It gives multiple users access to the system through an *emulation* interface between the server and a network client.

Terminal Server is a multi-user Windows operating system. Once a connection is made between Terminal Server and the client, all processing is performed by the server. The client acts as a remote picture tube and keyboard/mouse.

In many companies, clients cannot access applications across the WAN or through dial-up, because of cost, administration, and performance problems. If your Infor ERP SyteLine servers are in a remote location, this might be a problem. You could use Terminal Server instead. Terminal Server is kept at the central site, so its administration is handled centrally. Performance is improved because network traffic consists of screen shots, keyboard strokes, and mouse movements.

**NOTE:** Special consideration should be taken when installing to Terminal Server or Citrix Metaframe to ensure the Infor ERP SyteLine Client will be available to all users. Please contact your Terminal Server administrator for assistance.
Infor Framework TaskMan and Background Tasks

This chapter describes the Infor Framework TaskMan: how it works, how to set it up after installation, how to control tasks and reports from within Infor ERP SyteLine forms, and how to troubleshoot problems with task management, report previews, or printing.

Overview

TaskMan (which is different from the Windows Task Manager) is a Windows service that:

- Polls the application database
- Executes SQL stored procedures
- Launches applications such as EDI, MRP, and APS
- Generates Crystal Reports.

Poll the Application Database

TaskMan polls the application database to identify new tasks to run. It uses the polling interval defined on the Intranets form. On startup it connects to the application database. When a task is found that is waiting to be run, the task information (including executable, type of task parameters, and user name) is queried and the appropriate processing is performed.

Execute SQL Stored Procedures

For a SQL stored procedure, the TaskMan launches a database process thread. The database process then connects to the application database. It logs in as the Infor ERP SyteLine user who submitted the task. The stored procedure is then executed using the process connection.

Launch Applications

TaskMan launches a system process to execute any valid Windows application such as EDI (EDIImporter.EXE) and the SyteLine Scheduler (AIM_BATS.EXE), enabling the application to carry out its processing. The application is executed under the user account used by the Infor ERP SyteLine TaskMan service.
Generate Crystal Reports

For a report, the TaskMan launches a system process (RunReport.EXE) to execute a Crystal Report. The RunReport.exe application then connects to the application database. It logs in as the Infor ERP SyteLine user who submitted the task. Once connected, it queries any user options for running the report, for example, output format or printer name.

Reports are run just like all other executable applications. The RunReport.exe application handles the actual report generation. The RunReport.exe application uses the Report Design Component (RDC) to specify the database connection and output format for running the report. Once these options are set, it prints the report.

Run IDO Methods

If an IDOMTH background task is set up, TaskMan instantiates an Infor ERP SyteLine IDO, and runs one of its methods.

Setup During Installation

TaskMan is installed and configured as part of the Infor ERP SyteLine installation. We recommend that you install TaskMan on the Utility Server. See the Infor ERP SyteLine Installation Guide for more information; however, much of the TaskMan setup is done behind the scenes. The installation process:

- Installs the TaskMan on the server, which places the RunReport.exe program, the TaskMan.exe program, the TMConfig.exe program, and other necessary files in the installfolder (typically Program Files\Infor\SyteLine).
- Sets up the following folders within the installfolder folder:
  - Errors. Errors generated by Crystal Reports are written to this directory, under subfolders that match the IDs of the users who submitted the reports (for example, TaskMan\Errors\johsmi).
  - Output Files. The finished Crystal Reports output files are written to this folder, under subfolders that match the IDs of the users who submitted the reports. File extensions such as .DOC or .HTM indicate the format of the report.
  - Reports. All existing Infor ERP SyteLine report definitions (.rpt files) created in Crystal Reports are placed here during installation. Any additional report definitions you create should also be placed here.

Error and output file names include the site name and task number, in the format taskname_site_tasknumber. If TaskMan is configured to run against two or more databases with the same site specification (for example, test and production databases) and name clashes occur, a single digit is appended to the file name to eliminate the clash. For example: APWirePostingReport_OH_150844_2.
Infor Framework TaskMan and Background Tasks

- Creates the TaskMan as a Windows Service on the utility server, set for Automatic startup. If you enter a Service Logon and Password during the TaskMan Configuration part of the installation, that domain user ID and password are used to determine the Windows user account that controls the service. (You can also set the Service Logon and Password from the Services dialog after installation is complete. Go to Start>Settings>Control Panel>Administrative Tools>Services.)

- Determines which Strings table in the Forms database to use when displaying report form labels. This is a language-dependent setting that appears in the Sites/Entities form (Forms Database Name field).

Setup After Installation

Before users can print or preview reports, or run other tasks as background processes, you need to perform the following setup tasks.

- Configure a printer on the Utility Server
- Define report/TaskMan settings on the Intranets form
- Define e-mail addresses if required
- Define report options
- Define any excluded tasks

Configure Printers

1. Log in to the server where TaskMan is installed (usually the Utility Server) using the same system administrator account that you used to install and run the Infor Framework TaskMan service.

2. Configure a default printer for the server, plus any other printers that you want TaskMan to print to. Printers must be configured using their UNC name (\PrintServer\PrinterName).

Define Report/TaskMan Settings on the Intranets Form

The Intranets form has a Reports/Taskman tab whose fields are used to set default values for TaskMan and for displaying or printing reports. You can leave most of these fields blank and accept the default values - but you must enter a TaskMan path for report preview. Some of these values can also be overridden on other forms. For more information, see the online help.

- Polling interval - the interval at which TaskMan queries the databases to see if tasks are waiting to run.
- Connection query and process timeouts - the time to wait before timing out after an attempt to connect to a database, return query results, or execute a database process.
- Maximum concurrent processes - the maximum number of tasks that TaskMan can run simultaneously.
- Send e-mail notification - enables e-mail notification for all users when reports are printed. See “Define E-mail Addresses if Required for additional requirements.”
- Default output and preview formats - the default format used when creating reports or previews.
- TaskMan path - the path to the folder containing the TaskMan utility.
- Report URL - the path to the folder or internet area where output files should be placed.
- Fax server - the path to the fax server, if one is set up. See the Infor ERP SyteLine Installation Guide appendix for information about setting up your fax server.

Define E-mail Addresses if Required

For any users who want to receive e-mail notification when a report completes, you need to enter an e-mail address in the Users form.

Define Report Options

Set the following options for specific users in the Report Options form:

- User name - the user ID (if any) to which these report options apply.
- Task name - the task name (if any) to which these options apply.
- Output format - the format to use for reports for this user/task. This overrides the format entered in the Intranets form.
- Printer name - the printer to use when the selected user submits the specified report. This printer must be defined as a network printer and must be configured on the server where TaskMan is installed. Also, the user ID set up as the owner of the TaskMan service (see page 21) must have print privileges for each printer defined here.
- E-mail notification - indicates whether an e-mail notification is sent to this user when this report is completed. See “Define E-mail Addresses if Required for additional requirements.
- Attach report - indicates whether the report is attached to the e-mail, if E-mail notification is set to Yes.

For more information on these fields, see the online help.

Define Excluded Tasks

If there are tasks which should not run at the same time in your system:

3. From the Background Task Definitions form, select a task and then click Excluded Tasks.

4. On the Excluded Tasks form, define the tasks that should not run at the same time as this task.
Managing Background Tasks

You may want or need to schedule some processes to run at certain times of day and at regular intervals. Use the following four forms to manage those processes:

- Background Queue
- Active Background Tasks
- Background Task Definitions
- Background Task History

Schedule Reports and Utilities to Run in the Background

If a report or utility has a Background option on its Actions menu, you can schedule the report or utility to run at a time you choose. The background task can be run once, or it can be set up as a recurring task that runs at certain times daily, weekly, or monthly.

1. From the report or utility form, select **Actions>Background**. The Background Queue form opens.
2. In the Background Queue form, specify whether you want the task to run once, or on a daily, weekly, or monthly basis.
3. Specify the times and dates as described in the online help.

Check Which Background Tasks are Running

When the Background Queue form is used to create a job, it creates an Active Background Task record with status WAITING and the appropriate task name and parameters. It then creates a SQL Server job using the task name as the job name.

1. Open the Active Background Tasks form.
2. Note the following:
   - Tasks whose status is READY will process right away and cannot be deleted from the queue from within Infor ERP SyteLine.
   - Tasks whose status is RUNNING are currently processing and cannot be deleted from the queue from within Infor ERP SyteLine.
   - Tasks with a WAITING status remain in the queue until their scheduling requirements (set in the Background Queue form) are met. You can delete a WAITING task from the queue.

**NOTE:** Although you can’t stop a background task with a status of READY or RUNNING from within Infor ERP SyteLine, you can use the Windows Task Manager to do so if you need to stop a long-running process. Note that the Windows Task Manager is different from the TaskMan described later in this chapter.

Delete a Waiting task

When you delete a task on the Active Background Tasks form, both the record and the corresponding SQL Server job are deleted.
It is possible to use the **Background Queue** form to add a task several times. This adds job steps to the SQL job. When you delete a task with multiple job steps from the Active Background Tasks form, be sure to delete the correct job step.

To delete the task, mark the record for deletion and then save it.

### View Background Tasks That Have Run

Use the **Background Task History** form to display information about background tasks that have been run, whether they have completed successfully or not.

Return codes generated by background tasks are displayed below:

- **Stored procedures** - Developers supply the exit status for a stored procedure within the coding of the procedure. Generally, the exit status of the stored procedure functions as its return code, which is returned by TaskMan and displayed on this form.

  **NOTE:** Task Manager is a Windows service which monitors the application database in order to execute background tasks. See “Overview” on page 19 for more information on Task Manager.

- **Executable programs** - Developers supply the exit status or return code for an executable program within the coding of the program. This return code is returned by TaskMan and displayed on this form.

- **Reports** - Background tasks of the type RPT are Seagate Crystal reports. The Crystal Report executable program (RunReport.exe) returns exit codes to TaskMan that are displayed on this form. If the return code indicates an error (and if Crystal Reports captured an error message) you can also consult the error log for additional information.

### Create a Background Task

**NOTE:** It is only necessary to create a background task for your company's custom forms. Background task definitions are already set up where needed for standard Infor ERP SyteLine forms, and those background task definitions are listed on the **Background Task Definitions** form. For greater detail about defining background tasks, see the online help.

Use the **Background Task Definitions** form to create a record that identifies each background task to TaskMan.

Every report and every utility or activity that can be run as a background process must be listed in the **Background Task Definitions** form.

Background tasks must meet the following requirements:

- The task name should match the form name to make it easier to identify.

- **Stored procedures** must be written in SQL and reside in your SQL application database. Utility and activity forms generally use the Executable Type SP (stored procedure).

- **Executable programs** must reside in a directory available to the directory where TaskMan resides.
Reports are created using Seagate Crystal Reports. The report output file must be placed in TaskMan's reports subdirectory on the server. Although the report uses a stored procedure, its Executable Type must be set to RPT, since it requires special handling through Crystal Reports.

1. Create a new record on the Background Task Definitions form.
2. Specify a task name (for example, RunCustomerOrderReport) and description.
3. Specify an executable:
   - For a Crystal report, specify the name of the report (for example, CustomerOrder) in the Executable Name field and the type of executable (RPT) in the Executable Type field.
   - For a stored procedure, specify the procedure name in the Executable Name field and select SP in the Executable Type field.
   - For an executable program, specify the program name and path in the Executable Name field and select EXE in the Executable Type field.
4. Click the buttons on the form to specify any report options or excluded tasks.
5. Save the record.

Your new background task can be called from any form as an event handler.

Store Options

For any report or utility in Infor ERP SyteLine, you can save the information you’ve entered for later use. Use the Store Options form to do this.

NOTE: System Administrators can store options for any user. Non-administrators can only store options for the current user.

1. After entering the desired information on the report or utility form, select Actions>Store Options to save your entries.
2. Provide the appropriate user name.
3. Create an ID in the ID field. For example, if you are storing options for the SSD Transaction Listing Report, you might create an ID of SSDTLR.
4. Click the OK button.

Get Options

Use the Get Options form to recall any stored options.

1. After storing options for a form, from that report or utility for which you want those options, select Actions>Get Options.
2. Choose the appropriate user name and ID. The ID was set on the Store Options form.
3. Click the OK button.

Options Defaults

Once you have stored options for a form, you can view them on the Options Defaults form.

1. Open the Options Defaults form.
2. Enter the user name, form name, and ID. Note that the form name is not the same as the form title.
3. Click the Filter-in-place button on the toolbar.

Troubleshooting

This section describes possible problems with TaskMan, and how to solve them. Additional problems and solutions that require programming modifications to reports are described in the *Infor ERP SyteLine Reporting* document.

Labels Not Replaced with String Table Values

Use the Site Name from the **General Parameters** form to select the correct record on the **Sites/Entities** form. Make sure that, for this site, there is a value in the Sites/Entities form's Forms Database Name field (in some versions, labeled as the Strings Table Specification field). If the forms database is on a different server than the application database, the field's value should also indicate the linked server name, in this format: `server_name.Forms_database`

Infor Framework TaskMan then determines the proper Strings table name by searching the specified Forms database for the Strings table associated with the current Infor ERP SyteLine session.

If labels are not translated, stop and restart TaskMan. The Strings Table Specification field (or Forms Database field) may have been modified after TaskMan was last started. TaskMan checks this value once, when it first starts up.

TaskMan Does Not Start

If TaskMan does not start and you see this message in the Application Event log - "No database definitions defined. TaskMan must be configured before starting the service" - then consider the following:

- Run the Server Service Configuration utility and verify that the correct application databases are configured for TaskMan.
- Infor Framework TaskMan may be running under a user ID that does not have privileges to access the registry. Try restarting the service to run as a local system account. If it starts, then the problem is with the user ID.
- In Windows, restart Infor Framework TaskMan as an active service.

No Output

Reports may be marked as Started and Completed in the **Background Task History** form, but there is no output in the TaskMan\Reports\Output Files folder. There are probably two or more instances of TaskMan monitoring the same database. To verify this, shut down the instance of TaskMan you think should be monitoring the database and resubmit the report. If the Background Task History record still gets updated, then there is at least one
more instance of TaskMan monitoring the database. To find out if this is the case, launch
the SQL profiler against the database to see what hosts were polling.

Intermittent Errors

The same report is run a number of times, sometimes running successfully, and other
times erroring out. This happens for all reports. Whether it succeeds or fails appears to be
random. This could occur because of the same problems described under the “No Output
heading. Alternatively, there may be two instances of TaskMan: one has the privileges
needed to run reports, but the other does not.

Reports Fail with Return Code -1,073,741,819

If you see this return code, an executable may have become corrupt. Try double-clicking
on the RunReport.exe file. If it does not open dialog boxes, the EXEs have been
corrupted, possibly by a virus. Delete them and copy them again from the installation CD.

Batches of a Report Fail

If multiple requests for a particular report are submitted in batches, and the reports fail if
more than 20 of them are submitted at once, then check the MaxConcurrent field on the
Background Task Definitions form. The value should be set to 20, since Crystal Reports
does not allow more than 20 instances of a given report to be running at one time.

Event Messages from TaskMan

TaskMan runs as a service under Windows, called Infor Framework TaskMan, and
generates event messages that you can view in the Microsoft Event Viewer. If you are
having problems with a background task, you can run TaskMan in debug mode (see page
30), which generates additional messages for the Microsoft Event Viewer.

The following messages are generated normally and do not require Infor Framework
TaskMan to be running in debug mode. If a database exception occurs, TaskMan tries to
retrieve and log the error message.

<function name> failed with return code <code> in <Taskman source file> at
<Source file line number>.

Abnormal termination of Task <n> (returncode = <code>). Performing rollback.

A stored procedure background task was rolled back due to one of the following
circumstances:

- The stored procedure generated a return code less than 0 or greater than 5.
- Executing the stored procedure generated an exception.

An unknown exception occurred. <Taskman source file>: <Source file line
number>
Canceling Process <taskname>, Task <n>

If TaskMan is shutdown, an event log message will be printed as each running background task that is a stored procedure is canceled.

Canceling Report <taskname>, Task <n>

If TaskMan is shutdown, an event log message will be printed as each running background task that is a report is cancelled. Some reports may be left hanging even if TaskMan is shut down.

Database <db>. RegCloseKey failed with return code <code>. <Taskman source file>:< Source file line number>

RegCloseKeyEx failed when trying to open the HKEY_LOCAL_MACHINE Registry. TaskMan will shut down.

Database <db>. RegOpenKey failed with return code <n>. <Taskman source file>:< Source file line number>

RegOpenKeyEx failed when trying to open the HKEY_LOCAL_MACHINE Registry. TaskMan will shut down.

Database <db>. RegQuery - DSN failed with return code <code>. <Taskman source file>:< Source file line number>

RegQueryValueEx failed when trying to retrieve the data source name from the Registry. TaskMan will shut down. Use the TaskMan Configuration utility to check the configuration of data sources.

Database <db>. RegQuery - PWD failed with return code <code>. <Taskman source file>:< Source file line number>

RegQueryValueEx failed when trying to retrieve the password from the Registry. TaskMan will shut down. Use the TaskMan Configuration utility to check the configuration of data sources.

Database <db>. RegQuery - UID failed with return code <code>. <Taskman source file>:< Source file line number>

RegQueryValueEx failed when trying to retrieve the user ID from the Registry. TaskMan will shut down. Use the TaskMan Configuration utility to check the configuration of data sources.

DSN <dsn> Database <db>. Login successful

Informational message.
Either the DSN or the SQL login was not set.  
Informational message.

RegisterServiceCtrlHandler failed with return code <n> in <Taskman source file> at <Source file line number>.

RSTaskMan shutdown: <n> tasks are running and will be canceled.
If TaskMan is shutdown while tasks are running, these tasks will be cancelled.

RSTaskMan starting: Version <n>
Informational message.

RSTaskMan Terminating
Informational message.

RSTaskMan Terminating - TaskMan Home Directory not properly detected
TaskMan could not determine its home directory and will shut down.

SetServiceStatus failed in <Taskman source file> at <Source file line number>.

StartServiceCtrlDispatcher failed with return code <n> in <Taskman source file> at <Source file line number>.
TaskMan was not able to start the Service Dispatcher.

TaskTypeCode not recognized
The task type was not EXE, RPT, SP, or IDOMTH.

TaskMan Debug Mode
If you are having problems with a background task, you can run TaskMan in debug mode. Doing so generates additional messages for the Microsoft Event Viewer.

To run TaskMan in debug mode:

5. In the list of services, select Infor Framework TaskMan.
6. If the Infor Framework TaskMan service is running, stop it.

   NOTE: When you stop TaskMan, all running tasks are terminated.
8. In the Properties dialog’s Start parameters field, enter debug. Then click the Start button to restart TaskMan.
9. When you finish debugging the problem, be sure to stop the Infor Framework TaskMan service, remove the debug parameter, and restart it.

**NOTE:** There is also an optional "nowait" parameter for TaskMan. If you are starting TaskMan manually, this keyword allows it to start faster.

**TaskMan Debug Mode Messages**

**<SPname> After Call <Taskman source file>:<Source file line number>**
This message is printed after a stored procedure is called.

**Active Task Set not open: <DatabaseInfo>. <Taskman source file>:<Source file line number>**
TaskMan is trying to clear database connections

**Cannot find last slash. <Taskman source file>:<Source file line number>**
Error while retrieving information about the home directory from which TaskMan is executing.

**Close process connection completed for Task <n>. <Taskman source file>:<Source file line number>**
Informational message.

**Closing database: <dsn>.<Taskman source file>:<Source file line number>**
Informational message.

**Closing process connection for Task <n>. <Taskman source file>:<Source file line number>**
Informational message.

**Could not instantiate CIntranetSet. <Taskman source file>:<Source file line number>**
TaskMan could not get the needed information from the Intranet table.

**Decrement <taskname> <tasknumber>. <Taskman source file>:<Source file line number>**
Informational message - TaskMan is decrementing the Running Tasks list when the task completes.

**DELETE ActiveBGTasks where TaskNumber = <n>. <Taskman source file>:<Source file line number>**
Informational message - the task is deleted from the active tasks table.
Deleting TaskInfo handle. <Taskman source file>:<Source file line number>
Informational message - TaskMan is cleaning up report (RPT) process handles.

DSN <dsn> Database <db> Connecting DB<n>: DSN <dsn> User <userID> Timeout: <n>. <Taskman source file>:<Source file line number>
TaskMan is processing the list of configured databases and establishing connections to them.

DSN <dsn> Database <db> DELETE ActiveBGTasks where TaskStatusCode = 'RUNNING'. <Taskman source file>:<Source file line number>
When TaskMan first establishes a connection to a database, it deletes any background tasks with a status of running.

DSN <dsn> Database <db>. Login successful. <Taskman source file>:<Source file line number>
Informational message.

DSN <dsn> Database <db> Opening Active Tasks record set. <Taskman source file>:<Source file line number>
Informational message.

DSN <dsn> Database <db> Num Databases <n>. Registry Information for Database #<db>
DSN <dsn> UID <userID> PWD **** String Table=<stringtable> Poll=<n> Process Timeout=<n> Connection Timeout=<n> Max Num Tasks=<n>
Informational message about the database connection.

DSN <dsn> Database <db> Total number of Requests = <n>. <Taskman source file>:<Source file line number>
Informational message.

Error retrieving TaskMan Module Name. <Taskman source file>:<Source file line number>
TaskMan retrieves its module name in order to get its home directory. There was an error in retrieving the module name, so TaskMan cannot determine its home directory.

Increment <taskname> <tasknumber> Total requests <n> Queue size <size>. <Taskman source file>:<Source file line number>
TaskMan is polling the table for active background tasks in the each configured application database.

No Intranet records found, using defaults. <Taskman source file>:<Source file line number>
Infor Framework TaskMan and Background Tasks

number>
TaskMan is using the default values because it could not find a matching Intranets record.

Opening Intranet record set. <Taskman source file>:<Source file line number>
Informational message.

Pause to ensure SQL Server is completely up. <Taskman source file>:<Source file line number>
TaskMan pauses to make sure that SQL Server has started before trying to access databases.

Poll=<n> Connect=<n> Process=<n> MaxNo=<n> NumRec=<n> site = <site> Intranet =<intranetname> String Table = <stringtable> URL = <URLpath> Format = <outputformat> ReportPath = <path> Email Notif = <emailnotification>. <Taskman source file>:<Source file line number>
TaskMan successfully queried the Intranet table and retrieved the information listed here.

Rpt task failed. <Taskman source file>:<Source file line number>
TaskMan failed while trying to run a task with an RPT extension.

ServiceMain starting. <Taskman source file>:<Source file line number>
Informational message.

SQLCancel failed. Deleting TaskInfo handle. <Taskman source file>:<Source file line number>
The SQL Cancel of the process and task was not successful.

SQLCancel of Task <tasknumber> completed. Return Code = <n>. <Taskman source file>:<Source file line number>
TaskMan canceled a stored procedure background task.

Task <tasknumber> <taskname>. An error occurred while waiting for the process to finish. Error return = <code> message = <message>. <Taskman source file>:<Source file line number>
A Windows error occurred.

Task <tasknumber> <taskname>. Call to AddProcessErrorLogSp failed for user <userID>. Return code = <code>. <Taskman source file>:<Source file line number>
TaskMan tried and failed to add a task message to Background Task History.
Task <tasknumber> <taskname>. Call to CloseSessionSp failed for task <taskname> user <userID>. Return code = <code>, Error message = <message>. Taskman source file:<Source file line number>
TaskMan could not retrieve the Report Options information.

Task <tasknumber> <taskname>. Call to GetTaskOptionsSp failed for task <taskname> user <userID>. Return code = <code>, Error message = <message>. Taskman source file:<Source file line number>

Task <tasknumber> <taskname>. Call to InitSessionContextSp failed for task <taskname> user <userId>. Return code = <code>, Error message = <message>. Taskman source file:<Source file line number>

Informational message.

Task <tasknumber> <taskname>. Calling sp.Call <Taskman source file>:<Source file line number>
Informational message.

Task <tasknumber> <taskname>. Can transact. Taskman source file:<Source file line number>
TaskMan could not start a stored procedure background task.

Task <tasknumber> <taskname>. Cannot transact. Taskman source file:<Source file line number>
TaskMan cannot start a transaction for a stored procedure task. The stored procedure is not executed.

Task <tasknumber> <taskname>. CloseSessionSp called with Input Parameter <sessionID>. Taskman source file:<Source file line number>
Informational message

Task <tasknumber> <taskname>. Could not close session <sessionID>. Taskman source file:<Source file line number>

Task <tasknumber> <taskname>. Creating directory <directory>. Result = <code>. Taskman source file:<Source file line number>
Informational message.

Task <tasknumber> <taskname>. Database not open. Cannot enter Process Error:
Task <tasknumber> <taskname>. DELETE ActiveBGTasks where TaskNumber = <n>. <Taskman source file>:<Source file line number>
Informational message - the task is deleted from the active tasks table.

Task <tasknumber> <taskname>. Error <code> <message> when starting Command - <commandline>. <Taskman source file>:<Source file line number>
An error occurred when TaskMan was starting the specified command.

Task <tasknumber> <taskname>. Error moving file <outputfile> to <new outputfile>. <Taskman source file>:<Source file line number>
TaskMan could not copy the output file to the OutputFile folder. Be sure permissions are set up properly, and the folder exists.

Task <tasknumber> <taskname>. Exiting RunTask: Removing Task from List. <Taskman source file>:<Source file line number>
The background task has finished running.

Task <tasknumber> <taskname>. Fax=<faxname>, Fax Server = <faxserver>, Output Format=<outputformat>. <Taskman source file>:<Source file line number>
Informational message.

Task <tasknumber> <taskname>. GetExitCodeProcess return = <n>. <Taskman source file>:<Source file line number>
This message displays the return code for an executable program background task.

Task <tasknumber> <taskname>. GetTaskOptionsSp called with Input Parameters <taskname>, <userID>, <stringID> returned Output Parameters format = <output format>, printer = <printer name>, email = <email notification>, attach = <attach report>, email address = <email address>, Return code = <code>, Error message = <message>, String Table = <string table>, Fax Server = <fax server>.<Taskman source file>:<Source file line number>
TaskMan is retrieving specific information about the run-time user requesting this report background task. This information is entered in the Report Options and Intranets forms.

Task <tasknumber> <taskname>. InitSessionContextSp called with Input Parameter <taskname>, returned Output Parameter <sessionID>, Return code = <code>. <Taskman source file>:<Source file line number>
Informational message.

Task <tasknumber> <taskname>. InitSessionContextSp failed. Could not call SP.
Task <tasknumber> <taskname>. MAPI Init failed. <Taskman source file>:<Source file line number>

E-mail services could not be started.

Task <tasknumber> <taskname>. No attachment sent: either the report was sent to the printer, the Task Type was not RPT, or the report didn't complete successfully. <Taskman source file>:<Source file line number>

Task <tasknumber> <taskname>. Opening user names failed. <Taskman source file>:<Source file line number>

TaskMan encountered a problem attempting to open the UserNames database table.

Task <tasknumber> <taskname>. Password decrypted. <Taskman source file>:<Source file line number>

Informational message.

Task <tasknumber> <taskname>. Profile Values -- String Table: <stringtable>, String ID: <stringID>, Fax: <fax name>, Email: <email address>, Number of copies: <n>, Printer: <printer name>. <Taskman source file>:<Source file line number>

Informational message.

Task <tasknumber> <taskname>. Return = <code> WaitForSingleObject return = <code>. <Taskman source file>:<Source file line number>

This message is entered immediately after a background task has ended.

Task <tasknumber> <taskname>. Running: <stored procedure>. <Taskman source file>:<Source file line number>

Informational message.

Task <tasknumber> <taskname>. Running EXE: <command line>. <Taskman source file>:<Source file line number>

Informational message.


This is the command line TaskMan executes to run a Crystal report. For debugging purposes, you can paste the following command line into a batch file and execute it: RunReport.exe <Command line>
**Task <tasknumber> <taskname>. Sending Fax: <command line>**

Informational message.

**Task <tasknumber> <taskname>. Setting Connection Timeout <n> and opening a connection for this task.<Taskman source file>:<Source file line number>**

TaskMan opened a connection for this background task that will be used to update the Task History table and to delete entries from the Active Task table in the application database.

**Task <tasknumber> <taskname>. Setting Process Timeout <n>. <Taskman source file>:<Source file line number>**

Informational message.

**Task <tasknumber> <taskname>. Stored Procedure call GetSQLServerLoginSp failed with return code <code> and error message <message>. <Taskman source file>:<Source file line number>**

TaskMan could not get the SQL login information needed to process the task.

**Task <tasknumber> <taskname>. Successful termination of Task. Performing commit. <Taskman source file>:<Source file line number>**

A stored procedure background task can be committed.

**Task <tasknumber> <taskname>. Unable to access <document path>. Fax not sent. <Taskman source file>:<Source file line number>**

TaskMan could not access the RTF file using the specified path. Check to see that the file and path exist and that permissions allow TaskMan access to it.

**Task <tasknumber> <taskname>. Unable to access <SendFax.exe path>. Fax not sent. <Taskman source file>:<Source file line number>**

TaskMan could not access the Fax.exe utility using the specified path. Check to see that the file and path exist and that permissions allow TaskMan access to it.

**Task <tasknumber> <taskname>. UPDATE ActiveBGTasks SET TaskStatusCode = 'RUNNING' where TaskNumber = <n>. <Taskman source file>:<Source file line number>**

As TaskMan selects a background task to run, it changes its status to running.

**Task <tasknumber> <taskname>. UPDATE BGTaskHistory SET CompletionDate = <date>, CompletionStatus = <status>, TaskErrorMsg = '<message>' where TaskNumber = <n>. <Taskman source file>:<Source file line number>**

Informational message.
Task <tasknumber> <taskname>. UPDATE BGTaskHistory SET ProcessId = <pid> WHERE TaskNumber = <n>. <Taskman source file>:<Source file line number>

This message displays the process ID (pid) for a background task. You can use the process ID to trace the status of a background task in the Windows TaskMan. This ID is also displayed in the Background Task History form.

Task <tasknumber> <taskname>. UserNames.Username = '<userID>'.<Taskman source file>:<Source file line number>

The user ID of the run-time user requesting the current background task.

Task <tasknumber> <taskname>. Usernames.Username = <userID> Groupname = <groupname>.<Taskman source file>:<Source file line number>

The user ID and group name of the run-time user requesting the current background task.

Taskman Error: TaskCounter is not keeping accurate count of Running Tasks. <Taskman source file>:<Source file line number>

The number of running tasks in the system does not match the task counter value.

Taskman home directory: <homedirectory>. <Taskman source file>:<Source file line number>

Informational message.

TaskMan Stopping: Clearing database connections. <Taskman source file>:<Source file line number>

Informational message.

The maximum number of concurrently running tasks is <n>. <Taskman source file>:<Source file line number>

Informational message.

<dsn> UID <userID> PWD **** String Table=<stringtable> Poll=<n> Process Timeout=<n> Connection Timeout=<n> Max Num Tasks=<n>. <Taskman source file>:<Source file line number>

Informational message.

UPDATE BGTaskHistory SET CompletionDate = <date>, CompletionStatus = <status>, TaskErrorMsg = '<message>' where TaskNumber = <n>. <Taskman source file>:<Source file line number>

Informational message.
Use SQL Profiler to Trace TaskMan Instances

NOTE: There can only be one instance of TaskMan monitoring an application database. Having more than one monitoring an application database can prevent report output from being placed in the output directory.

You can use SQL Profiler to see which instance of TaskMan is monitoring an application database.

1. Select Start>All Programs>Microsoft SQL Server 2005>SQL Server Management Studio.
2. Select Tools>SQL Server Profiler.
4. Connect to the application database server you want to trace.
5. On the Events Selection tab, remove everything from the Events column except TSQL -- SQL:Batch completed.
6. Click Run to start the trace.

Stored Procedures Used for Performance Benefit

The following are stored procedures you should run regularly for performance benefit:

- **sp_updatestats** - Run this SQL-supplied stored procedure regularly for statistics updating for all tables in a database. You can get more information about this stored procedure from the SQL online help.
- **SLServerRestartSp** - This stored procedure runs whenever the database server is restarted (since no one is logged in at that time) and performs general cleanup.
- **PurgeNextKeysSp** - Run this stored procedure to clean up the NextKeys table. NextKey records are inserted, never updated to get concurrency. This stored procedure cleans out the extra rows. DO NOT run this utility while others are using the system. The utility will lock users out, but you should log everyone out of the system before running this utility.
License Management

As System Administrator, you need to manage your license agreement, and Infor ERP SyteLine allows you to do that. Use the following three forms to manage your license:

- License Management Form
- Licensed Modules Form
- User Modules Form

Types of Users

There are two kinds of users:

- **Multi-session User** - Multi-session users are shown in the Multi-Session Users tab on the License Management form. Most installations will have one entry here, where the user name is SL_Internal. See “Multi-Session Users” on page 43 for more information about multi-session users.
- **Single-session User** - Single-session users are all the other users that appear in the Users form.

License Document

You need a license document to apply your licenses. Infor provides this document in the form of a .txt document upon the purchase of an Infor product. If you do not have your license document, contact Infor Customer Service. There are three different kinds of licenses:

- **Production License** - This is the license you use to run your live system. Only one production license key is provided to you at a time. If you require a new production license key, you must sign an affidavit stating you are no longer using an old production key in any manner.
- **Demo Database License** - This license key is provided so that more than one person in your company can have access to the Demo Database for testing purposes. This license is only valid for 90 days. There is a fixed user count of 10 for any module that is user based. The system warns you each time you logon within 30 days of the expiration date that the license is about to expire.
- **Pilot System License** - This license allows you to run a copy of your production environment in a pilot or testing environment. The license is limited to 10 users or 20 percent of the production license count, whichever is greater. The system warns you each time you logon within 30 days of the expiration date that the license is about to expire. Once the license expires, you cannot open forms.

**License Management Form**

This form allows you to manage your company’s license agreement. The form shows when the license begins and ends, which modules are licensed, and it is where you apply the license to stay current.
Apply A License

1. On the **License Management** form, click the **Apply License** tab.

2. Paste your license document into the **License Document** field. You can cut and paste the information from the license document into this field, or you can select the **Browse** button and select the document from your drive. The document is encrypted and every character counts, so if you copy and paste, make sure to copy the entire document.

3. Once you have entered the license document, click the **Apply License** button. Any previous multi-session users that you had are deleted and replaced with the ones defined in the new license document. See “Multi-Session Users” on page 43 for information about multi-session users.

**NOTE:** Let's assume you are applying a new license to replace an old one for the SyteLineTrans Users module. The old license was for 50 users, and the new one is for 40. When you click the Apply License button, you get an error message. If the new license is for fewer users than the old license, you need to go to the Users Module form and delete users' association with the SyteLine Trans Users module until you have the same amount or fewer than the new license allows. If your new license is for the same number of users or more, then you can apply the license and you don't need to do anything else.

Post License Application Steps

**NOTE:** You must follow the steps in this section if there were active WinStudio sessions when you applied the license. If there were not any active sessions, you can skip this step. You can perform these steps, however, in either case.

1. On the utility server, open the **Configuration Manager** (**Start>All Programs>Infor>Tools>Configuration Manager**).
2. Select the **Utilities** tab.

3. Use the **Utilities** tab to discard the Runtime Service Cache for all configurations that reference the application database to which the new license has just been applied. See the Configuration Manager online help for more information about the options on this tab.
Multi-Session Users

On the License Management form, click the Multi-Session user tab to see the form as shown above.

A multi-session user is able to have more than one session open at a time. This is necessary for Data Collection users.

All Infor ERP SyteLine customers are given one multi-session user named SL_Internal. This user can have 5 concurrent sessions. If you are a data collection user, you will get one additional session.

If you are not a multi-session user and you try to login on machine B while you are still logged in on machine A, you get a message asking if you want to end the session on machine A. If you do this, your session on machine A is deleted and you are logged in on machine B. Any unsaved data on machine A is lost, so only end that session if you are sure you have saved all your data.

The SL_Internal user needs to have the appropriate permissions set in the Users form. See the Infor ERP SyteLine Installation Guide for information on how to appropriately set those permissions.
Licensed Modules Form

This form lists the modules for which your company is licensed, and it allows you to add a description for each module. You can also see the modules for which your company is licensed on the Licensed Modules tab of the License Management form. The License Management form also shows the number of licensed users, beginning and expiration dates for the license, and whether your license is valid. The License Modules form exists primarily for users who don’t have permission to open the License Management form but still need to see which licenses the company has.

User Modules Form

Use this form to associate a named user with a certain module for which your company has a license. For example, user Bob might be associated with the SyteLine Trans Users module. This means that user Bob is taking one of your company’s license tokens for the SyteLine Trans Users module. A named user can be associated with different modules, but each association takes a token for each licensed module. Tokens are taken when you assign a user to a module, not when the user logs in.
Possible license modules and their associated access capabilities are:

<table>
<thead>
<tr>
<th>License Module</th>
<th>Access Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>SyteLine APS</td>
<td>APS Mode form to enable APS</td>
</tr>
<tr>
<td>SyteLineAutomation</td>
<td>IDO Access, Microsoft Outlook integration, Microsoft Project integration</td>
</tr>
<tr>
<td>SyteLineCRM</td>
<td>Allows SyteLine customers who also use Epiphany CRM to enter estimates and orders in SyteLine</td>
</tr>
<tr>
<td>SyteLineDC</td>
<td>No Infor ERP SyteLine forms; only IDO access for data collection transactions</td>
</tr>
<tr>
<td>SyteLineDC_MS</td>
<td>You need a SyteLineDC license for each data collection device used in its &quot;home&quot; site, and a SyteLineDC_MS license for each other site where that data collection device might be used.</td>
</tr>
<tr>
<td>SyteLineDev</td>
<td>Allows access to developer forms.</td>
</tr>
<tr>
<td>SyteLineEntity</td>
<td>All GL Entity forms (functions)</td>
</tr>
<tr>
<td>SyteLineInquiry</td>
<td>All Query forms, All Report Options forms, Customer Inquiry, Vendor Inquiry, Item Availability</td>
</tr>
<tr>
<td>SyteLineTrans</td>
<td>All Infor ERP SyteLine forms</td>
</tr>
<tr>
<td>SyteLineTransMultiSite</td>
<td>All Infor ERP SyteLine forms. The SytelineTransMultiSite module is for users who require access to multiple sites. Assign a SytelineTrans license in the user’s &quot;home&quot; site and a SytelineTransMultiSite license in any other sites where access is required for that user.</td>
</tr>
<tr>
<td>SyteLineWorkflowAutomation</td>
<td>No Infor ERP SyteLine forms; only IDO access</td>
</tr>
</tbody>
</table>

Multiple Logins

A single-session user (named user) cannot have more than one active session at a time.

Using data collection users as an example, the same user cannot log into Infor ERP SyteLine and then log into web-based data collection. The user can only log into one at a time. The user can either log out of one before logging into the other, or a separate user can be set up for Infor ERP SyteLine and web-based data collection.

NOTE: If you try to use the same userID for more than one session in web-based data collection, you might be able to log on, but errors will occur when you navigate between fields and transactions are committed to the database. Data entered will be lost. Infor only supports single session access to Web Based Data Collection.

When setting up data collection users, assign:

- the SyteLineDC module for web-based data collection.

When setting up Infor ERP SyteLine users, assign:
the SyteLineTrans module for Infor ERP SyteLine (which includes data collection forms).

**NOTE:** All web-based data collection users, when assigned to the SyteLineDC module, must also be assigned to the Data Collection IDO group.

All data collection users, when assigned to the SyteLineTrans module for Infor ERP SyteLine, must also be assigned to groups. Example groups are as follows: Shop Floor Control, Purchasing, Payroll, Order Entry, Inventory, Data Collection.

### Recover Locked Tokens

If Infor ERP SyteLine terminates unexpectedly, it is possible that license tokens in use at the time are locked, thus preventing users from logging in. In this case, use the **Session Management** form to free up the locked tokens. See the Infor ERP SyteLine online help for more information about the **Session Management** form.
In Infor ERP SyteLine, each site's database does not have to be connected to any other database in order to function. Data is transferred through a process called replication. The system manages its own replication which is different from SQL's replication. We do not support standard SQL replication as a means to transfer data from one site to another.

The connection between sites can be either:

- **Transactional** - This is a constant live connection from one site to another. Any update is made to the target site immediately. The down side is that if the target site is down for any reason, the transfer of data does not occur;

  Or

- **Non-transactional** - There is no live connection between sites. If using a non-transactional (also referred to as delayed replication or asynchronous replication) setup, data that is shared must be replicated.

For more detailed information on replication and multi-site use, see these documents on www.infor365.com:

- *Replication Reference*
- *Multi-Site Planning Guide*
- *Multi-Site Implementation Guide*
You may limit user access to certain forms or limit what they can do on certain forms by way of authorizations. Use the following four forms to manage these authorizations:

- Object Authorizations for User
- Object Authorization for Group
- Users
- Groups

Object Authorizations For User

Use this form to set up form-level security for a user or to set up security for a user based on a middle-tier IDO. An object in this case is either the name of the form or the name of the IDO.

If the user specified on this form is part of a group, the user authorizations that you set up on this form override any group authorizations that apply to the same user.

You can open the form right from the Explorer window, or you can click the User Authorizations button on the Users form.
The following privileges can be granted or revoked for the user for a specified form in the Object Authorizations For User form:

- **Delete** controls whether the user can delete records.
- **Edit** controls whether the user can edit existing data.
- **Execute** controls all privileges, including whether the user can open the form. When execute is revoked, all privileges are unavailable.
- **Insert** controls whether the user can insert records.
- **Read** controls whether the user can read data.
- **Bulk Update** controls whether the user can perform a bulk update, such as multiple find and replace operations.
- **Update** controls whether the user can save changes to existing data.

### Object Authorization for Group

Use this form to set up form-level security for a group of users or to set up security for a group based on a middle-tier IDO.

Any user authorizations for individuals will override the group authorizations defined on this form.

You can open the form right from the Explorer window, or you can click the **Group Authorizations** button on the **Groups** form.

The following privileges can be granted or not granted for the group in the Object Authorization For Groups form:

- **Delete** controls whether the user can delete records.
- **Edit** controls whether the user can edit existing data.
- **Execute** controls all privileges, including whether the user can open the form. When execute is not granted, all privileges are unavailable.
- **Insert** controls whether the user can insert records.
- **Read** controls whether the user can read data.
- **Update** controls whether the user can save changes to existing data.
- **Bulk Update** controls whether the user can perform a bulk update, such as multiple find and replace operations.

**Users**

![Users dialog box]

Use this form to register users to the application. A user ID is required for each user who logs on to the application. You can also specify the following:

- Passwords needed to log on to the application
- Workstation IDs so users bypass the logon dialog box
- E-mail addresses so notifications can be sent about automated tasks
- Editing permissions that determine whether users can enter edit mode to create or customize forms
- Security authorizations for this user at a form level or a component level
Groups to which the user belongs and security authorizations for that group
Additional information about the user that the application needs.

NOTE: Initially, only the supplied default system administrator user ID can create or delete other user IDs.

Any user who is added to the System Administration group or designated as a super user can access the Users form and change the password for any other user. Users can change their own passwords on the User Information form.

Groups

Use the Groups form to create groups and to assign user IDs to them. These groups can be organized in any way that makes sense for your company or organization -- by location, by organization, by job description, and so on.

CAUTION: Although the system allows you to modify or delete the default groups, doing so may cause future conversion problems while upgrading and other problems. We recommend you copy the records from the default group to a new group name and modify that. Do NOT delete or modify default groups.

Assign users to groups so you can then create group authorizations that apply to every individual/user ID in the group.
Create a Super User

A Super User can run all forms and perform all actions on all forms for which they hold a license. In some cases, actions may have to be performed by the 'sa' user account. For example, a user with a SyteLine Entity module license can not access the User Modules form. In this case, you need to access the User Modules form with the 'sa' user account.

If you create a Super User, you do not need to set any other authorizations for this user. The Super User status overrides all other types of authorizations.

1. Open the Users form.
2. Select the desired User ID.
3. Select the Super User field.
4. Save the record.

Assign a User to a Group

1. Open the Users form.
2. Select the desired User ID.
3. On the Groups tab, select the Group Name from the drop down list.
4. Save the record.

NOTE: When you assign a user to a group (for example, user Bob is assigned to the Accounts Payable Group), that user gets access to all the forms associated with that group. If you want user Bob to have most of the access associated with that group but not all, you need to edit the user authorizations for user Bob. See “Edit Authorizations for a User in a Group” on page 54.

Assign a User to a Primary Group

In general, it is easier to first create the group, then assign user authorizations. This allows you to assign each user a Primary Group that specifies authorizations without going through each user's authorizations form by form.

1. On the Users form, select the desired User ID.
2. On the Groups tab, select the group name from the Group Name drop down list.
3. Select the **Primary Group** field.

   When selected, this field indicates that the corresponding user group is a primary group. The system uses the group designated as the Primary Group to load the correct version of customized forms for the selected user.

   Users may belong to more than one group, but only one group may be designated as the Primary Group, and only the Primary Group is used for loading group versions of a customized form. For example, suppose user Bob is a member of the Accounts Payable and Accounts Receivable groups with the Accounts Receivable group marked as Bob’s primary group. If the user Bob launches a form, the system looks for a group-level customized version of that form for the Accounts Receivable group, not the Accounts Payable group. If such a customized version exists, and if there isn’t also a user-level customized version for user Bob, then that is the form the system will display.

**View Group Authorizations**

1. Open the **Groups** form.
2. Select the desired group name.
3. Click the **Group Authorizations** button. The **Object Authorization for Group** form opens.
4. In the **Object Name** field, select an object. The privileges are listed in the columns to the right, and those privileges are either granted or not granted.

**Edit Authorizations for a User in a Group**

User authorizations override group authorizations. So for example, you might want user Bob to have all of the authorizations of the accounts payable group, except for access to the Accounting Periods form.

1. Assign a user to a group on the **Groups** form (See “Assign a User to a Group” on page 53).
2. Open the **Users** form.
3. Select the user whose authorizations you want to edit.
4. Click the **User Authorizations** button. The **Object Authorizations for User** form opens.
5. In the **Object Name** field, select the object you wish to edit for this user. In this example, it is AccountingPeriods.
6. Depending on what you want, change the desired privileges either to **Granted** or **Revoked**.
Forms Security

Form level security is checked when a user opens a form. The AccountAuthorizations table is queried to see what privileges have been granted to the user or to the group to which the user belongs.

Change Passwords

Any user who is added to the System Administration group or designated as a super user can access the Users form and change the password there for any other user. Users without such authorization can change their own passwords on the User Information form shown below.

Copy User Tables

If you upgrade from one version of SyteLine 7 to another version of SyteLine 7 (example - 7.04 to 7.05) or to Infor ERP SyteLine (example - 7.05 to 8.02), you can copy your user and group authorizations to the new version with the Copy User Tables utility so you don’t have to set them up again.

Requirements

- This utility should only be used when first setting up a database for use and NOT after users have already been defined and Foreign Key references have been added.
- The latest version of Infor ERP SyteLine must be installed and licensed before running this utility.

NOTE: If your latest license is for fewer users than your old license, not all users will carry forward. When you complete the procedure, open the Users form in the new Infor ERP SyteLine version to check the users. You can then make changes accordingly.
1. On the Utility Server, select **Start>Programs>Infor>Tools>Copy User Table**. The following screen appears:

2. On the **Source** tab, enter the following information:
   - **SQL Server Name** - Enter the name of the SQL Server or select it from the list.
   - **SQL Server Login ID** - Enter your SQL Server Login ID.
   - **SQL Server Logon Password** - Enter your SQL Server Logon Password.
   - **Use Windows Authentication** - Select this field to use Windows Authentication. This means that instead of supplying a SQL Server login/password, the server uses the username of the person currently logged in to the Windows machine and logs in automatically.
   - **Source Database** - Select the name of the application database with the user/group authorizations you want to copy.
3. Click the **Target** tab. The screen appears as follows:

![Copy User Tables](image)

4. On the **Target** tab, enter the following information:
   - **SQL Server Name** - Enter the name of the SQL Server or select it from the list.
   - **SQL Server Login ID** - Enter your SQL Server Login ID.
   - **SQL Server Logon Password** - Enter your SQL Server Logon Password.
   - **Use Windows Authentication** - Select this field to use Windows Authentication. This means that instead of supplying a SQL Server login/password, the server uses the username of the person currently logged in to the Windows machine and logs in automatically.
   - **Target Database** - Select the name of the application database to which you want to copy the user/group authorizations.
5. Click the **SyteLine Login** tab. The screen appears as follows:

![Copy User Tables window](image)

6. Enter the following information:
   - **User ID** - Enter your SyteLine user ID.
   - **Password** - Enter the SyteLine password associated with the user ID.
   - **Data Source Config** - Select the target application database from the drop down list.

7. Click the **Copy** button. The status bar shows the progress. The process can take several minutes.

   **NOTE:** In the SyteLine directory on the utility server, is a file named `UserTables.txt`. This file lists the tables that are copied by the Copy User Table utility.

**Group Lists**

The lists below contain the form name for the form, not the form title, so look for the form you want based on the form name. In most cases, the form name and form title are similar
(Bank Addresses as the form title and BankAddresses as the form name), but not in all cases. For example, the form name for the Bank Reconciliations form is BankCodes.

NOTE: The system provides you with default groups. You can use these groups, modify these groups, or you can create your own. Modify or create your own groups on the Groups form. Do NOT delete any groups.

Following is a list of the groups provided with the system and the forms to which those groups have access or the process associated with the group. These groups are listed on the Groups form. Select the group and then click the Group Authorizations button to see the level of authorization that group has.

Accounts Payable Group
1099FormPrintingReport
AccountsPayableAgingReport
ActivateDeactivatePostedTransactionsAP
APagingBuckets
APagingBucketsDomesticCurrency
APCheckPrintingPosting
APDraftPrintingPosting
APEFTPosting
APPaymentDistribution
APPaymentDistributionQuery
APPaymentGeneration
APPayements
APPayementsQuery
APPaymentTransactionReport
APPostedTransactionsDetail
APPostedTransactionsDetailDomesticCurrency
APPostedTransactionsDetailQuery
APPostedTransactionsSummary
APPostedTransactionsSummaryDomesticCurrency
APPostingDraftRemittance
APQuickPaymentApplication
APRecurringVoucherGeneration
APVoucherPosting
APVouchersandAdjustmentDomesticCurrency
APVouchersandAdjustments
APVouchersandAdjustmentsQuery
APWirePosting
CashRequirementsReport
CurrencyRevaluationUtility
DeleteAPPostedTransactions
DeleteVoucherPreregisters
DraftRemittance
DraftRemittanceDomesticCurrency
DraftRemittancePostingReport
DraftRemittanceQuery
ECSSDs
ECSSDsDomesticCurrency
ECSSDsQuery
ECVATReport
GSTInputTaxCreditReport
ManualVoucherBuilder
PaymentHoldReasons
PSTInputTaxCreditReport
PurchaseVATRegister
RecurringVoucherDistribution
RecurringVoucherDistributionDomesticCurrency
RecurringVoucherDistributionQuery
RecurringVoucherDomesticCurrency
RecurringVouchers
RecurringVouchersQuery
SiteGroups
TaxPayableReport
TaxVouchered(Parametric)Report
TaxVouchered-ParametricReport
TransactionDetailAP
TransactionDetailAPDomesticCurrency
VendorVoucherDebitMemoReport
VoucherAdjustmentDistribution
VoucherAdjustmentDistributionDomesticCurrency
VoucherAdjustmentDistributionQuery
VoucherAuthorization
VoucherAuthorizationReport
VoucherListing
VoucherListingDomesticCurrency
VoucherPreregister
VoucherPreregisterDistributions
VoucherPreregisterDistributionsDomesticCurrency
VoucherPreregisterDistributionsQuery
VoucherPreregisterDomesticCurrency
VoucherPreregisterQuery
VoucherPreregisterReport
VoucherRegisterbyAccountReport
VoucherRegisterReport
VoucherTransactionReport

Accounts Receivable Group
AccountsReceivableAgingReport
ActivateDeactivatePostedTransactionsAR
ARAdjustmentPosting
ARAge
ARAgeBuckets
ARAgeBucketsDomesticCurrency
ARBalanceHistory
ARDraftCancellation
ARDraftPosting
ARDraftPurge
ARDraftRemittance
ARDraftRemittanceDomesticCurrency
ARDraftRemittanceQuery
Authorizations

ARFinanceChargeGeneration
ARInvoiceCreditDebitMemoReport
ARInvoiceDueDates
ARPaymentDistributions
ARPaymentDistributionsQuery
ARPaymentMultipleDueDates
ARPaymentPosting
ARPAYments
ARPAYmentsQuery
ARPaymentTransactionReport
ARPostedInvoiceDueDates
ARPostedTransactionDetailDomesticCurrency
ARPostedTransactionsDetail
ARPostedTransactionsDetailQuery
ARPostedTransactionsSummary
ARPostedTransactionsSummaryDomesticCurrency
ARPostingDraftRemittance
ARQuickPaymentApplication
ARWirePosting
CashReceiptsDueReport
ConsolidatedInvoicing
CorporateCustomerReport
CurrencyRevaluationUtility
CustomerDocProfile
CustomerDocProfileQuery
CustomerStatementsReport
DeleteARPostedTransactions
DraftAgingReport
DraftDunningLetterReport
DraftTransactionReport
DunningReport
ECSalesListReport
ECSSDs
ECSSDsDomesticCurrency
ECSSDsQuery
ECSupplementaryStatisticalDeclarationReport
ECVATReport
FinanceChargePosting
FinanceCharges
FinanceChargesDomesticCurrency
FinanceChargesQuery
FinanceChargeTransactionReport
GSTInvoicedReport
IncompleteSSDOrderInformationReport
InvoiceCategories
InvoiceDebitandCreditMemoSequences
InvoiceDebitandCreditMemoSequencesQuery
InvoiceListing
InvoiceListingDomesticCurrency
InvoicePayDayReport
InvoicePosting
InvoiceRevisionDayReport
InvoicesDebitandCreditMemos
InvoicesDebitandCreditMemosDomesticCurrency
InvoicesDebitandCreditMemosGLDistQuery
InvoicesDebitandCreditMemosGLDistribution
InvoicesDebitandCreditMemosGLDistributionDomestic
InvoicesDebitandCreditMemosQuery
InvoiceTransactionReport
LettersofCreditbyCustomerReport
Notes
OrderInvoicingCreditMemo
PSTInvoicedReport
RebalanceCustomerLettersofCredit
ReturnedChecks
SalesTaxReport
SalesVATRegister
SiteGroups
SSDTransactionListingReport
TaxInvoiced(Parametric)Report
TaxInvoiced-ParametricReport
Tax Receivable Report
TransactionDetailAR
TransactionDetailAR Domestic Currency
VoidARPostedDraft
VoidedInvoicesDebit and Credit Memos
VoidedInvoicesDebit and Credit Memos Query
Void Invoice Debit and Credit Memo Reason Codes
Void Unused Invoices

Advanced Manufacturing Group
APSPushPassSetting
ComponentShortagesAPS
ComponentShortagesReportAPS
DemandDetailMRPAPS
DemandDetailScheduler
DemandSummaryMRPAPS
DemandSummaryScheduler
Exception Message Priorities
Exceptions Report
Firm Planned Order
Forecast
Forecast Query
Infinite APS Mode
Inventory Level
Inventory Summary
Inventory Summary MRPAPS
ItemBottlenecksReportMRPAPS
ItemsWithNetChangeFlagSetReport
MasterPlanningDisplay
MasterPlanningDisplayQuery
MasterPlanningReport
MasterProductionSchedule
MasterProductionScheduleFirmMPSOrder
MasterProductionScheduleQuery
MaterialPlannerWorkbench
MaterialPlannerWorkbenchFirmJob
MaterialPlannerWorkbenchFirmMPSOrder
MaterialPlannerWorkbenchFirmPO
MaterialPlannerWorkbenchFirmProductionSchedule
MaterialPlannerWorkbenchFirmPurchaseRequisition
MaterialPlannerWorkbenchFirmTransferOrder
MaterialPlannerWorkbenchGeneration
MaterialPlannerWorkbenchQuery
MaterialPlannerWorkbenchSummary
MPSProcessor
MRPGeneration
MRPMode
MRPOrderActionReport
MRPPlanning
PeggingDisplay
PeggingDisplayQuery
PeggingReport
PlannedPhantomUsage
Planning
PlanningDetail
PlanningDetailAPS
PlanningDetailFirmJob
PlanningDetailFirmPO
PlanningDetailFirmPurchaseRequisition
PlanningDetailFirmTransferOrder
PlanningDetailQuery
PlanningHorizonCalendar
PlanningHorizonCalendarQuery
PlanningMode
PlanningParameters
PlanningSummary
PlanningSummaryQuery
PostPlannedTransferRequirements
ProjectedItemCompletionsbyResGroupReportMRPAPS
ProjectedItemCompletionsByResourceReportMRPAPS
ProjectedItemCompletionsReportMRPAPS
ResequencePlanningIntervals
ResourceGanttChart
ResourceGanttChartMRPAPS
ResourceGroupBottlenecksAPS
ResourceGroupBottlenecksReportAPS
ResourceGroupLoadProfileMRPAPS
ResourceGroupPlan
ResourceGroupPlanQuery
ResourceGroupUtilizationMRPAPS
ResourceLoadProfileMRPAPS
ResourcePlan
ResourcePlanQuery
ResourceUtilizationMRPAPS
SupplyUsageMRPAPS
SupplyUsageReportMRPAPS
WorkCenterSequencing

APS - Override Projected Date Group
For internal processing only
APS - Set Due Date < Projected Group
For internal processing only

Credit Field Update Group
For internal processing only

Data Collection Group
BarcodedEmployeeBadgesReport
BarcodedIntermecUtilityMenuReport
BarcodedItemLabelsReport
BarcodedReaderMenuReport
BarcodedResourcesReport
ChangeWarehouse
CurrentTimeAttendanceTransactionsListing
CustomerOrderShippingErrorProcessing
CustomerOrderShippingErrorProcessingQuery
CycleCountingErrorProcessing
CycleCountingErrorProcessingQuery
DataCollectionParameters
GenerateAntaresConfiguration
HistoryTimeandAttendanceTransactionsListing
JobErrorProcessing
JobErrorProcessingQuery
JobMaterialTransactionsErrorProcessing
JobMaterialTransactionsErrorProcessingQuery
JobReceiptErrorProcessing
JobReceiptErrorProcessingQuery
JustInTimeProductionErrorProcessing
JustInTimeProductionErrorProcessingQuery
MiscIssue/ReceiptAndQtyAdjustErrorProcessing
MiscIssue/ReceiptAndQtyAdjustErrorProcessingQuery
PhysicalInventoryErrorProcessing
PhysicalInventoryErrorProcessingQuery
PostedJobTransactionsListing
ProductionScheduleCompleteErrorProcessing
ProductionScheduleCompleteErrorProcessingQuery
ProductionScheduleScrapErrorProcessing
ProductionScheduleScrapErrorProcessingQuery
PurchaseOrderReceivingErrorProcessing
PurchaseOrderReceivingErrorProcessingQuery
PurgeCustomerOrderShippingTransactions
PurgeCycleCountTransactions
PurgeJITProductionTransactions
PurgeJobMachineAndWorkCenterTransactions
PurgeJobMaterialTransactions
PurgeJobReceiptTransactions
PurgeMiscIssue/ReceiptAndQtyAdjustTransactions
PurgeProductionScheduleTransactions
PurgePurchaseOrderReceivingTransactions
PurgeQuantityMoveTransactions
PurgeTimeAttendanceLogTransactions
PurgeTimeAttendanceTransactions
PurgeTransferOrderShipReceiveTransactions
PurgeWorkCenterMaterialTransactions
QuantityMoveErrorProcessing
QuantityMoveErrorProcessingQuery
ReaderConfiguration
ReaderConfigurationQuery
SFCTransactionsAwaitingPostFromDC
TimeAttendanceErrorProcessing
TimeAttendanceErrorProcessingQuery
TimeAttendanceLog
TimeAttendanceLogTransactionsReport
TimeAttendanceMonitor
TransferOrderReceiveErrorProcessing
TransferOrderReceiveErrorProcessingQuery
TransferOrderShipErrorProcessing
TransferOrderShipErrorProcessingQuery
UnpostedJobTransactionsListing
ValidateAntaresConfiguration
ValidateDataCollectionTransactions
WorkCenterLaborErrorProcessing
WorkCenterLaborErrorProcessingQuery
WorkCenterMachineTimeErrorProcessing
WorkCenterMachineTimeErrorProcessingQuery
WorkCenterMaterialErrorProcessing
WorkCenterMaterialErrorProcessingQuery

Data Collection Hide Costs Group
JobErrorProcessing
JobErrorProcessingQuery
JobMaterialTransactionsErrorProcessing
JobMaterialTransactionsErrorProcessingQuery

Data Collection IDO Group (Web-based DC Transaction Group)

NOTE: If you are a Web-based Data Collection user, you must have object authorizations on the Middleware level, not the form level. These authorizations can be seen on the Object Authorizations for User form.

AccountAuthorizations
MGCore.ApplicationMessages
MGCore.LanguageIDs
MGCore.UserModules
MGCore.UserNames
SL.SLColitems
SL.SLCos
SL.SLDccos
SL.SLDclitems
SL.SLDcjits
SL.SLDcjms
SL.SLDcmoves
SL.SLDcparms
SL.SLDcphyinvs
SL.SLDcpos
SL.SLDcPss
SL.SLDcsfcs
SL.SLDctas
SL.SLDctrans
SL.SLDcwcs
SL.SLEmployees
SL.SLIndCodes
SL.SLItemlocs
SL.SLItems
SL.SLJobmatls
SL.SLJobRoutes
SL.SLJobs
SL.SLLotLocs
SL.SLLots
SL.SLMSMoves
SL.SLObjectMainMessages
SL.SLParms
SL.SLPhyinvs
SL.SLPickMachByWcs
SL.SLPoltems
SL.SLPos
SL.SLPsitems
SL.SLReasons
SL.SLResrc000s
SL.SLShifts
SL.SLTransfers
SL.SLUMs
SL.SLUUserLocals
SL.SLWcs
SL.SLWhses

Delivery Orders Group
BillofLadingReport
ChangeDOBOLStatusUtility
CopyDeliveryOrders
CustomerDocProfile
CustomerDocProfileQuery
DeleteDeliveryOrders
DeliveryOrderLines
DeliveryOrderLinesDomesticCurrency
DeliveryOrderLineSequences
DeliveryOrderLineSequencesDomesticCurrency
DeliveryOrderLineSequencesQuery
DeliveryOrderLinesQuery
DeliveryOrders
DeliveryOrdersDomesticCurrency
DeliveryOrdersQuery
GenerateDeliveryOrderLineSequences
MassDOAssignment
PrintDeliveryOrderASNGenerateEDIASN
PrintDeliveryOrderPackingSlipReport
PrintDeliveryOrderProFormaInvoiceReport

Delivery Orders Hide Prices Group
DeliveryOrderLines
DeliveryOrderLineSequences
DeliveryOrderLineSequencesQuery
DeliveryOrderLinesQuery
DeliveryOrders
DeliveryOrdersDomesticCurrency
DeliveryOrdersLines
DeliveryOrdersLineSequences
DeliveryOrdersLineSequencesQuery
DeliveryOrdersLinesQuery
DeliveryOrdersQuery

Engineering Change Notices Group
ChangeECNLineStatus
ChangeECNStatusUtility
ChangeItemRevision
CopyEngineeringChangeNotices
ECNbyItemReport
ECNDistributionCodes
ECNPriorityCodes
ECNReasonCodes
ECNReport
ECNStatusReport
EngineeringChangeNoticeItems
EngineeringChangeNoticeItemsQuery
EngineeringChangeNotices
EngineeringChangeNoticesQuery
HistoryEngineeringChangeNoticeItems
HistoryEngineeringChangeNoticeItemsQuery
HistoryEngineeringChangeNotices
HistoryEngineeringChangeNoticesQuery
JobsAffectedbyEngineeringChangeNoticesReport
MaterialSubstitutionECNItemGeneration
Notes
PostEngineeringChangeNotice
ReusableNotes

Engineering Change Notices Approve Group
Change an ECN's status from Requested to Approved
Engineering Change Notices Est Delete Group
Delete an ECN estimate

Engineering Change Notices Est Insert Group
For internal processing only

Engineering Change Notices Est Update Group
For internal processing only

Engineering Change Notices Est View Costs Group
For internal processing only

Engineering Change Notices Job Delete Group
Delete an ECN job

Engineering Change Notices Job Insert Group
For internal processing only

Engineering Change Notices Job Update Group
For internal processing only

Engineering Change Notices Job View Costs Group
For internal processing only

Engineering Change Notices Post Group
Perform the posting process in the PostEngineeringChangeNotice form

Engineering Change Notices Std Delete Group
Delete an ECN

Engineering Change Notices Std Insert Group
For internal processing only

Engineering Change Notices Std Update Group
For internal processing only

Engineering Change Notices Std View Costs Group
For internal processing only
Engineering Change Notices Hide Costs Group
EngineeringChangeNoticeItems
EngineeringChangeNoticeItemsQuery
HistoryEngineeringChangeNoticeItems
HistoryEngineeringChangeNoticeItemsQuery

Electronic Data Interchange Group
CARaSCommodityCodeExtraction
CARaSCustomerAddressExtraction
CARaSCustomerAddressMaintenanceReport
CARaSPartsExtraction
CARaSPartsReport
CARaSShipViaExtraction
DemandEDIParametersInterfaceSetup
EDIAccumulativeCharges
EDICustomerOrderBlanketLines
EDICustomerOrderBlanketLinesDomesticCurrency
EDICustomerOrderBlanketLinesQuery
EDICustomerOrderBlanketReleases
EDICustomerOrderBlanketReleasesDomesticCurrency
EDICustomerOrderBlanketReleasesQuery
EDICustomerOrderLines
EDICustomerOrderLinesDomesticCurrency
EDICustomerOrderLinesQuery
EDICustomerOrders
EDICustomerOrdersDomesticCurrency
EDICustomerOrdersErrorLog
EDICustomerOrdersQuery
EDICustomerProfiles
EDICustomerProfilesQuery
EDIEstimatedTotalCharges
EDIPurchaseOrderAckBlnLineReleasesDomesticCurrency
EDIPurchaseOrderAckBlnLineReleasesQuery
EDIPurchaseOrderAckLinesDomesticCurrency
EDIPurchaseOrderAckLinesQuery
EDIPurchaseOrderAcknowledgeBlnLineReleases
EDIPurchaseOrderAcknowledgeDomesticCurrency
EDIPurchaseOrderAcknowledgeErrors
EDIPurchaseOrderAcknowledgeLines
EDIPurchaseOrderAcknowledgments
EDIPurchaseOrderAcknowledgmentsQuery
EDIPurchaseOrderChangeReport
EDIPurchaseOrderRequirementReport
EDIPurchaseOrderStatusReport
EDITransactionLoadRoutine
EDITransactionLogReport
EDITransactionUnloadRoutine
EDIVendorProfiles
EDIVendorProfilesQuery
ExtractEDIPlanningSchedules
InboundPOAcknowledgmentReport
InboundPurchaseOrderErrorReport
InboundVendorInvoiceReport
InboundVendorShipNoticeReport
OutboundEDIInvoiceReport
OutboundPlanningScheduleReport
OutboundPOAcknowledgeReport
OutboundPurchaseOrderReport
OutboundShippingNoticeReport
OutboundShippingScheduleReport
PurgeEDIAdvanceShippingNotices
PurgeEDICustomerOrders
PurgeEDIInvoices
PurgeEDIPlanningSchedules
PurgeEDIPOAcknowledgments
PurgeEDIPOAcknowledgmentsInbound
PurgeEDIIPurchaseOrders
PurgeEDIShipSchedules
PurgeEDIVendorInvoices
PurgeEDIVendorShipNotices
RetransmitEDIAdvanceShippingNotices
RetransmitEDIAdvanceShippingNoticesListing
RetransmitEDIInvoices
RetransmitEDIInvoicesListing
RetransmitEDIPurchaseOrdersListing
RetransmitEDIPlanningSchedules
RetransmitEDIPlanningSchedulesListing
RetransmitEDIPOAcknowledgments
RetransmitPOAcknowledgmentsListing
SupplyEDIParametersInterfaceSetup
TransactionSummaryReport
WhereUsedEDIcustomerProfiles

Electronic Data Interchange Hide Costs Group
For internal processing only

Employee Hourly Group
For internal processing only

Employee Salaried Group
For internal processing only

Enter Out Of Date Range Group
For internal processing only
Entity Forms Group
AccountingPeriods
AccountingPeriodsQuery
AccountUnitCodeRemovalUtility
AuthorizationGroups
AuthorizationUsers
BackgroundQueue
BackgroundQueueSetup
BGTaskDefinitions
BGTaskDefinitionsQuery
BGTaskHistory
BGTaskHistoryQuery
Calculator
ChangeReportsToEntity
ChangeSite
ChartOfAccountAllocations
ChartOfAccountAllocationsQuery
ChartOfAccountBudgetAndPlan
ChartOfAccountBudgetAndPlanQuery
ChartOfAccounts
ChartOfAccountsQuery
ComponentAuthorizationGroups
ComponentAuthorizationUsers
CompressGeneralLedgerTransactions
CopyUnitCodesToAccounts
CountryCodes
CurrencyCodes
CurrencyCodesQuery
CurrencyRates
CurrencyRatesQuery
ExciseCurrencyRates
FinancialReportAccountCheck
FinancialReportLineCopyUpdate
FinancialReportLineGeneration
FinancialStatementDefinition
FinancialStatementDefinitionColumns
FinancialStatementDefinitionColumnsQuery
FinancialStatementDefinitionQuery
FinancialStatementGroups
FinancialStatementGroupsQuery
FinancialStatementLineDefinition
FinancialStatementLineDefinitionQuery
FinancialStatementLineResequence
FinancialStatementOutput
FinancialStatementOutputGetGroup
FinancialStatementPreview
GeneralLedger
GeneralLedgerCheckInformationReport
GeneralLedgerTransactionReport
GeneralLedgerWorksheetReport
GeneralParameters
GLPostedTransactions
GLPostedTransactionsAccountSummary
GLPostedTransactionsAccountSummaryQuery
GLPostedTransactionsQuery
GroupsMaint
GroupsMaintQuery
InactiveAccountNumbersReport
ISOCountryCodes
ISOCurrencyCodes
ISOUMCodes
ManualReplicationUtility
MultiCurrencyParameters
MultiSiteChartCopy
PeriodSortingMethods
ProjectLaborTransaction DomesticCurr
RebalanceLedgerPeriodTotals
RefreshAcctUnitCombinations
ReplicationCategories
ReplicationCategoriesQuery
ReplicationManagement
ReplicationRules
ReplicationRulesQuery
SiteEntities
SiteEntitiesQuery
SiteGroups
StdGraphDefinition
TransactionDetailAP
TransactionDetailAP DomesticCurrency
TransactionDetailAR
TransactionDetailAR DomesticCurrency
TransactionDetailMaterialTransaction
TransactionDetailMaterialTransaction DomesticCurr
TransactionDetailMaterialTransaction DomesticCurren
TransactionDetailProjectLaborTransaction
TransactionDetailVoucherPreRegister
TransactionDetailVoucherPreRegister DomesticCurr
TransactionDetailVoucherPreRegister DomesticCurrenc
TrialBalance
TriggerManagement
UnitCode1s
UnitCode2s
UnitCode3s
UnitCode4s
UnitCodeReplacementUtility
UnlockLockedFunctions
UnlockLockedJournals
Update_AllTables
UsersMaint
UsersMaintQuery
VerifyReportsToAccountsReport

ERPConfiguration Group
ConfigurationPurgeUtility
ConfigurationValues

Estimating Group
CopyOrdersAndEstimates
CustomerDocProfile
CustomerDocProfileQuery
EstimateCommissionDistribution
EstimateCommissionDistributionQuery
EstimatedMaterials
EstimatedMaterialsQuery
EstimatedOperations
EstimatedOperationsQuery
EstimatedTotalCharges
EstimateJobBillofMaterialProcessor
EstimateJobBOMCostRollUp
EstimateJobIndentedBOMReport
EstimateJobOrders
EstimateJobOrdersQuery
EstimateJobRoutingReport
EstimateLines
EstimateLinesDomesticCurrency
EstimateLinesQuery
EstimateResponseFormReport
Estimates
EstimatesDomesticCurrency
EstimatesQuery
EstimatesQuickEntry
EstimateStatusReport
ExportRoutingBOM
MaterialAvailabilityReport

Estimating Costs
EstimateJobCostDetailReport
EstimatesbyProfitReport
EstimateWorksheetReport
EstimationWorksheet

Estimating Hide Costs Group
EstimatedMaterials
EstimatedMaterialsQuery
EstimatedOperations
EstimatedOperationsQuery
EstimatedTotalCharges
EstimateLines
EstimateLinesQuery
Estimates
EstimatesDomesticCurrency
EstimatesQuery
EstimatesQuickEntry
EstimateStatusReport

Estimating Hide Prices Group
EstimateLines
EstimateLinesDomesticCurrency
EstimateLinesQuery
EstimateResponseFormReport
Estimates
EstimatesDomesticCurrency
EstimatesQuery
EstimatesQuickEntry

External Financial Interface Forms Group
ExternalFinancialInterfaceDataRequestUtility
ExternalFinancialInterfaceParameters

Fixed Assets Group
BonusDepreciationCodes
DisposalPosting
FixedAssetAcquisitionReport
FixedAssetClassCodes
FixedAssetClassCodesQuery
FixedAssetClassificationReport
FixedAssetCostReport
FixedAssetCosts
FixedAssetCostsQuery
FixedAssetCurrentDepreciationReport
FixedAssetDepreciation
FixedAssetDepreciationPosting
FixedAssetDepreciationQuery
FixedAssetDepreciationTables
FixedAssetDepreciationTablesQuery
FixedAssetDisposal
FixedAssetDisposalDistributions
FixedAssetDisposalDistributionsQuery
FixedAssetDisposalQuery
FixedAssetDisposalTransactionReport
FixedAssetDispositionReport
FixedAssetGenerateDepreciationCalculation
FixedAssetInsuranceReport
FixedAssetParameters
FixedAssetQuarterlyCostIncurredReport
FixedAssets
FixedAssetsQuery
FixedAssetTransfer
FixedAssetTransferPosting
FixedAssetTransferQuery
FixedAssetTransferReport
FixedAssetYearEndProcedure
WhereUsedBonusDepreciationCodes
WhereUsedFixedAssetClassCodes

General Ledger Group
AccountingPeriodControlNumberSequences
AccountingPeriodControlNumberSequencesQuery
AccountingPeriods
AccountingPeriodsQuery
ALPostedTransactions
ALPostedTransactionsAccountSummary
ALPostedTransactionsAccountSummaryQuery
ALPostedTransactionsQuery
BankAccountRevaluationUtility
BankAddresses
BankAddressesQuery
BankCodes
BankCodesQuery
BankReconciliationCompression
BankReconciliationReasonCodes
BankReconciliationReport
CashImpactReport
ChartofAccountAllocations
ChartofAccountAllocationsQuery
ChartofAccounts
ChartofAccountsBudgetandPlan
ChartofAccountsBudgetandPlanGrowth
ChartofAccountsBudgetandPlanQuery
ChartofAccountsQuery
CopyBalancestoBudgets
FinancialReportAccountCheck
FinancialReportLineCopyUpdate
FinancialReportLineGeneration
FinancialStatementDefinition
FinancialStatementDefinitionColumns
FinancialStatementDefinitionColumnsQuery
FinancialStatementDefinitionQuery
FinancialStatementGroups
FinancialStatementGroupsQuery
FinancialStatementLineDefinition
FinancialStatementLineDefinitionQuery
FinancialStatementLineResequence
FinancialStatementOutput
FinancialStatementOutputGetGroup
FinancialStatementPreview
GeneralLedger
GeneralLedgerCheckInformationReport
GeneralLedgerTransactionReport
GeneralLedgerWorksheetReport
GLPostedTransactions
GLPostedTransactionsAccountSummary
GLPostedTransactionsAccountSummaryQuery
GLPostedTransactionsQuery
InactiveAccountNumbersReport
JournalAccountSummary
JournalCompress
JournalControlNumberReport
JournalEntries
JournalEntriesQuery
JournalResequecing
Journals
JournalsQuery
JournalTransactionMaintenanceReport
JournalTransactionReport
JournalTransactions
LedgerControlNumberReport
LedgerPostingforJournal
LinkedChartOfAccountToUnitCode1
LinkedChartOfAccountToUnitCode2
LinkedChartOfAccountToUnitCode3
LinkedChartOfAccountToUnitCode4
MassJournalPosting
MultiSiteChartCopy
PeriodSortingMethods
PeriodSortingMethodsQuery
ProjectLaborTransactionDomesticCurr
RecalculateJournalBalances
TransactionDetailMaterialTransaction
TransactionDetailMaterialTransactionDomesticCurr
TransactionDetailProjectLaborTransaction
TransactionDetailVoucherPreRegister
TransactionDetailVoucherPreRegisterDomesticCurr
TrialBalance
UnitCode1s
UnitCode2s
UnitCode3s
UnitCode4s
UnitCodeWhereUsedReport

Goods Receiving Notes Group
ChangeGoodsReceivingNoteStatus
DeleteGoodsReceivingNotes
GenerateGoodsReceivingNoteLines
GoodsReceivingNoteReport
GoodsReceivingNotes
GoodsReceivingNotesLandedCosts
GoodsReceivingNotesLandedCostsDomesticCurrency
GoodsReceivingNotesLandedCostsQuery
GoodsReceivingNotesLines
GoodsReceivingNotesLinesQuery
GoodsReceivingNotesQuery
GRNLandedCostAllocation
VendorASNReconciliationReport

Human Resources Group
AbsenceReasons
ApplicantCertLicense
ApplicantCertLicenseQuery
ApplicantEducation
ApplicantEducationQuery
ApplicantExams
ApplicantExamsQuery
ApplicantMemos
ApplicantMemosQuery
ApplicantProcessing
ApplicantProcessingQuery
ApplicantReferences
ApplicantReferencesQuery
Applicants
ApplicantSkills
ApplicantSkillsQuery
ApplicantSourceAnalysisReport
ApplicantsQuery
ApplicantTrainingCourses
ApplicantTrainingCoursesQuery
ApplicantWorkExperience
ApplicantWorkExperienceQuery
ApplicationSources
Attendance
AttendanceQuery
AwardsCitations
CertificationsLicenses
Children
ChildrenQuery
CobraBenefitsSummaryReport
Companies
CompaniesQuery
CopyFromApplicant
DepartmentSupervisors
Divisions
DivisionsQuery
EducationMajors
EEOClasses
EmergencyContacts
EmergencyContactsQuery
EmployeeAwards
EmployeeAwardsQuery
EmployeeCertLicense
EmployeeCertLicenseQuery
EmployeeEducation
EmployeeEducationQuery
EmployeeEEOStatusReport
EmployeeExams
EmployeeExamsQuery
EmployeeInjuries
EmployeeInjuriesQuery
EmployeeInsurance
EmployeeInsuranceQuery
EmployeeMemos
EmployeeMemosQuery
EmployeePerformanceReviews
EmployeePerformanceReviewsQuery
EmployeePositionHistory
EmployeePositionHistoryQuery
EmployeePositions
EmployeePositionsQuery
EmployeeProcessing
EmployeeProcessingQuery
EmployeeReimbursementPlans
EmployeeReimbursementPlansQuery
Employees
EmployeeSalary
EmployeeSalaryQuery
EmployeeSalaryUpdate
EmployeeSickLeave
EmployeeSickLeaveQuery
EmployeeSkills
EmployeeSkillsQuery
EmployeesQuery
EmployeeStatus
EmployeeStatusQuery
EmployeeTrainingCourses
EmployeeTrainingCoursesQuery
EmployeeVacation
EmployeeVacationQuery
EmployeeWorkExperience
EmployeeWorkExperienceQuery
EmploymentEligibility
EmploymentEligibilityQuery
EthnicID
Exams
ExEmployeeOutstandingLoansReport
HealthInsuranceSummaryReport
HRYearEndProcedure
HumanResourcesParameters
I9Documents
I9DocumentsQuery
Insurance
InsuranceQuery
InsuranceSummaryReport
Interviews
InterviewsQuery
MemoTopics
MilitaryService
NumberOfEmployeesbyDeptReport
Offices
OfficesQuery
PositionChangeReasons
PositionClassifications
PositionRequirements
Positions
PositionsQuery
ProcessingSteps
Property
ReimbursementPlans
ReimbursementPlansQuery
ReviewTypes
SalariesbyDepartmentReport
SalariesbyEEOClassReport
SalariesbyGenderReport
SalariesbyPositionClassReport
SalaryChangeReasons
SickLeaveParameters
Skills
TerminationReasons
TrainingCourses
TrainingCoursesQuery
VacationParameters
VacationParametersQuery
W2StatetoBeConsolidated
WantAdCostAnalysisReport
WantAds
WantAdUsage
WantAdUsageQuery
WhereUsedAbsenceReasons
WhereUsedApplicationSources
WhereUsedDepartments
WhereUsedEEOClasses
WhereUsedEmployeeCertLicense
WhereUsedEmployeeStatus
WhereUsedExams
WhereUsedMilitaryService
WhereUsedPositionChangeReasons
WhereUsedPositionClassifications
WhereUsedSalaryChangeReasons
WhereUsedSickLeaveParameters
WorkExperience

Human Resources Hide Costs Group
AwardsCitations
Employees
EmployeesQuery
Positions
PositionsQuery
TrainingCourses
TrainingCoursesQuery
WantAdCostAnalysisReport

Internal System Users

NOTE: If you are a multi-session user, you must have object authorizations on the Middleware level, not the form level. These authorizations can be seen on the Object Authorizations for User form.

MGCore.ActiveBGTasks
MGCore.DefineVariables
MGCore.UserGroupMaps
MGCore.UserNames
SL.SLBankHdrs
SL.SLCoblIns
SL.SLCoitems
SL.SLCos
SL.SLCoShips
SL.SLCurrencyCodes
SL.SLCurrParms
SL.SLCustomers
SL.SLDccos
SL.SLDccoSerials
SL.SLDcltems
SL.SLDcitemSerials
SL.SLDcjits
SL.SLDcjitSerials
SL.SLDcjms
SL.SLDcjmSerials
SL.SLDcmoves
SL.SLDmoveSerials
SL.SLDcparsms
SL.SLDcphyinvs
SL.SLDcpos
SL.SLDcpoSerials
SL.SLDcpss
SL.SLDcpsSerials
SL.SLDcsfcs
SL.SLDcsfcSerials
SL.SLDctas
SL.SLDctrans
SL.SLDctranSerials
SL.SLDcwcs
SL.SLDwcwSerials
SL.SLDiscouts
SL.SLEmployees
SL.SLItemCusts
SL.SLItems
SL.SLJobtMats
SL.SLJobTrans
SL.SLObjectNotes
SL.SLParms
SL.SLPodCodes
SL.SLRmaiitems
SL.SLRmas
SL.SLSfromashValues
SL.SLSites
SL.SLSiteUserMaps
SL.SLSlsmans
SL.SLTerms
SL.SLltJobtMatPosts
SL.SLUsrforms
SL.SLVendors

Inventory Group
ABCAnalysis
AdvanceShipNoticeLineItems
AdvanceShipNoticeLineItemsQuery
AdvanceShipNotices
AdvanceShipNoticesQuery
BOMImportBuilder
BOMListing
ChangeItemPrice
ChangeItemStatusUtility
ChangeTransferLineStatusUtility
ChangeWarehouse
CombinedTransferOrderShip/Receive
CoproductMixes
CoproductMixesQuery
CoproductMixOperations
CoproductMixOperationsQuery
CoproductMixReport
CoproductMixStatusReport
CoproductWhereUsedReport
CopyItems
CopyRoutingBOM
CopyTransferOrders
COTransactionsbyLotReport
CreateTagExtractFile
CurrentMaterials
CurrentMaterialsQuery
CurrentOperations
CurrentOperationsQuery
CustomerDocProfile
CustomerDocProfileQuery
CustomerOrderKitBuilder
CustomerOrderKitPickList
CycleCountGeneration
CycleCountingTransactions
CycleCountPosting
CycleCountPurge
CycleCountSetup
CycleCountSheetReport
CycleCountUpdate
CycleCountVarianceReport
DeleteBillofMaterialComponents
DeleteItemRevision
DeleteItemStockroomLocations
DeleteLots
DeleteSerials
DeleteTaxFreeExports
DeleteTaxFreeImports
DistributionAccounts
DistributionAccountsQuery
ExportRoutingBom
FamilyCodes
FamilyCodesQuery
GenerateCoproductMixCostDistribution
GenerateFromPackingSlip
GenerateFromTransferOrder
GlobalItems
GlobalItemsQuery
IndentedCurrentBillofMaterialReport
InputUpdateSheets
InputUpdateTags
InvAdjustmentMiscIssueReceiptTransactions
InventoryAdjustmentReasonCodes
InventoryAdjustmentReasonCodesQuery
InventoryAgingReport
InventoryBalanceReport
InventoryBelowSafetyStockReport
InventoryCostReport
InventoryLevel
InventoryPreAdjustmentReport
InventorySummary
ItemBOMWhereUsedReport
ItembyLocationReport
ItemCurrentRoutingReport
ItemDetailReport
ItemLIFOFIFODetail
ItemLIFOFIFODetailQuery
ItemLIFOFIFOSummary
ItemLotLocations
ItemLotLocationsQuery
ItemLotReport
ItemNotUsedReport
ItemPricing
ItemPricingDomesticCurrency
ItemPricingQuery
ItemQuantitiesbyABCCodeReport
ItemRevisionReport
Items
ItemSerialNumberReport
ItemsQuery
ItemStockroomLocations
ItemStockroomLocationsQuery
ItemWarehouses
ItemWarehousesQuery
ItemWhereUsedReport
JobMaterialKitBuilder
JobMaterialKitPickList
JobReceipt
LeadTimeProcessor
ListItemLotLocWithCntInProc
LoadPhysicalInventoryRecords
Locations
LocationsQuery
Lots
LotsQuery
LotTraceabilityReport
MaterialTransactions
MaterialTransactionsQuery
MaterialTransactionsReport
MiscellaneousIssue
MiscellaneousIssuesReasonCodes
MiscellaneousIssuesReasonCodesQuery
MiscellaneousReceipt
MiscellaneousReceiptReasonCodes
MiscellaneousReceiptReasonCodesQuery
MultiLingualItem
MultiSiteQuantityMove
NatureofTransactionCodes
ObsoleteSlowMovingReasonCodes
PhysicalInventoryApproval
PhysicalInventoryCountPosting
PhysicalInventoryRecordPurge
PhysicalInventoryReport
PhysicalInventoryTransactions
PlanningBOMReport
PostLIFOFIFOChangesReport
PrintAdvancedShipNoticeReport
PrintInventorySheets
PrintInventoryTags
ProductCodes
ProductCodesQuery
ProFormaInvoiceReport
ProjectedInventoryReport
ProjectResourceKitBuilder
ProjectResourceKitPickList
QuantityAdjustment
QuantityMove
RanksForAlternateMaterial
ReprintTransferShipPackingSlipReport
ReservationsforItem
ReservationsReport
SecondaryNatureofTransactionCodes
SerialNumbers
SerialNumbersforItemLotLocations
SerialNumbersQuery
SetTagSheetControls
SingleLevelCurrentBillofMaterialReport
SingleLevelCurrentBOMCostRollUp
SingleLevelLotSourceReport
SingleLevelLotWhereUsedReport
StandardMaterials
StandardMaterialsQuery
StandardOperations
StandardOperationsQuery
StockMovementTransactions
SubstituteBillofMaterialComponents
SummarizedCurrentBillofMaterialReport
SupplementaryUnitsConversionFactorUpdate
TaxFreeExports
TaxFreeExportsQuery
TaxFreeImportedMaterialsProcessUtility
TaxFreeImportItemQuery
TaxFreeImportItems
TaxFreeimportItemsQuery
Authorizations

- TaxFreeImports
- TaxFreeImportsQuery
- TimePhasedInventoryStatus
- TransactionsbySerialNumberReport
- TransferLossReasonCodes
- TransferLossReasonCodesQuery
- TransferOrderItemXRefProcessing
- TransferOrderKitBuilder
- TransferOrderKitPickList
- TransferOrderLandedCosts
- TransferOrderLandedCostsQuery
- TransferOrderLineItems
- TransferOrderLineItemsQuery
- TransferOrderLoss
- TransferOrderReceive
- TransferOrderReceivingListReport
- TransferOrderReturnReasonCodes
- TransferOrderReturnReasonCodesQuery
- TransferOrders
- TransferOrderShip
- TransferOrderShipPickList
- TransferOrdersQuery
- TransferOrdersQuickEntry
- TransferOrderStatusReport
- TransferPackingSlipQuery
- TransferPackingSlipSelection
- TransferReceiveTransactions
- TransferShipPackingSlip
- TransferShipTransactions
- UMs
- UnitofMeasureConversion
- UnitofMeasureConversionQuery
UnvoidInventoryTagsSheets
ValidateCoproductMixCostDistribution
VoidInventoryTagsSheets
VoidTagSheetReport
Warehouses
WarehousesQuery
WhereUsedDistributionAccounts
WhereUsedLocations
WhereUsedPriceCodes
WhereUsedWarehouses

Inventory Costs Group
IndentedCostedBillOfMaterialReport
ItemCostbyProductCodeReport
ItemCostingReport
TotalInventoryValuebyAcctReport

Inventory Costs Maintenance Group
ItemCosts
ItemCostsQuery
ItemWarehouseCosts
ItemWarehouseCostsQuery

Inventory Hide Costs Group
CycleCountVarianceReport
InventoryCostReport
ItemDetailReport
ItemLIFOFIFODetail
ItemLIFOFIFODetailQuery
ItemLIFOFIFOSummary
ItemLotLocations
ItemLotLocationsQuery
ItemPricing
ItemPricingDomesticCurrency
ItemPricingQuery
Items
ItemsQuery
ItemStockroomLocations
ItemStockroomLocationsQuery
MaterialTransactionsReport
SummarizedCurrentBillOfMaterialReport

Item Hide Prices Group
ItemDetailReport
PlanningBOMReport

Item Maint - Rev Track Group
Update the Revision Tracking component on the Items form

Item Stockroom - Remote Insert Group
Item Stockroom - Remote Insert Group

MGR - Accounts Payable Group
AccountsPayableParameters
APPeriodYearEndProcedure
CADInterfaceParameters
EuroExchangeRateRevaluation
GeneralParameters
MoveLocalVendors
MultiCurrencyParameters
PurgeVoucherHistory
RebalanceVendorPayHistory
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery
VendorEuroCurrencyConversion
VoidAPPostedPayments
VoidPostedDraftPayments

**MGR - Accounts Receivable Group**
AccountsReceivableParameters
ARPeriodYearEndProcedure
CADInterfaceParameters
CustomerEuroCurrencyConversion
DemandEDIParametersInterfaceSetup
EuroExchangeRateRevaluation
GeneralParameters
MoveLocalCustomers
MultiCurrencyParameters
PurgeInvoiceHistory
RebalanceCustomerPayHistory
ResidualARBalanceEliminations
TaxParameters
TaxSystems
TaxSystemsQuery

**MGR - Data Collection Group**
For internal processing only

**MGR - General Ledger Group**
AccountUnitCodeRemovalUtility
BankReconciliationChangeUtility
CADInterfaceParameters
CompressGeneralLedgerTransactions
CopyUnitCodesToAccounts
DemandEDIParametersInterfaceSetup
GeneralParameters
JournalBuilder
MultiCurrencyParameters
RebalanceBankReconciliation
RebalanceLedgerPeriodTotals
RefreshAcctUnitCombinations
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery
UnitCodeReplacementUtility
YearEndClosingJournalEntries

MGR - Human Resources Group
CADInterfaceParameters
DemandEDIParametersInterfaceSetup
GeneralParameters
HRYearEndProcedure
MultiCurrencyParameters
SickLeaveCalculation
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery
VacationCalculation
YearEndProcedure

MGR - Inventory Control Group
CADInterfaceParameters
CurrentBillOfMaterialProcessor
CurrentBOMCostRollUp
DeleteMaterialTransactions
Freeze/UnfreezeInventory
GeneralParameters
InventoryParameters
ItemInitialization
ItemInitializationQuery
ItemStockroomLocationMassCreation
ManualLIFO/FIFOAdjustmentUtility
MultiCurrencyParameters
OrderEntryParameters
PurgeTransferOrders
RebalanceItemAllocatedtoOrder
RebalanceItemQtyAllocatedtoJobandWIP
RebalanceItemQtyAllocatedtoTransfer
RebalanceItemQtyOnHand
RebalanceItemQtyReserved
RollCurrentCoststoStandardCost
SetItem/WarehousePTDandYTDtoZero
SetVendorItemCustItemPTDYTDToZero
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery
TimePhasedInventoryStatus
TransferOrderParameters
WarehousetoWarehouseBulkTransfer

MGR - Order Entry Group
CADInterfaceParameters
CustomerEuroCurrencyConversion
CustomerOrderHeaderWarehouseChange
CustomerOrderLineReleaseWarehouseChange
DeleteCustomerOrderLineItemLogEntries
EuroExchangeRateRevaluation
GeneralParameters
MoveLocalCustomers
MultiCurrencyParameters
OrderEntryParameters
PurgeInvoiceHistory
RebalanceCustomerBalances
RebalanceCustomerLettersofCredit
RebalanceItemAllocatedtoOrder
SetUpCommissionTableLabels
SetVendorItemCustItemPTDYTDToZero
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery

MGR - Payroll Group
CADInterfaceParameters
DeletePayrollTransactions
DemandEDIParametersInterfaceSetup
ExternalPayrollInterfaceParameters
ExternalPayrollInterfaceParametersQuery
GeneralParameters
MultiCurrencyParameters
PayrollParametersGeneral
PayrollYearEndProcedure
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery
VoidPRPostedPayments

MGR - Purchasing Group
CADInterfaceParameters
EuroExchangeRateRevaluation
GeneralParameters
MoveLocalVendors
MultiCurrencyParameters
PurchaseOrderHeaderWarehouseChange
PurchaseOrderLineReleaseWarehouseChange
PurchasingParameters
PurgeVoucherHistory
RebalanceItemOnPurchaseOrder
RebalanceVendorLettersofCredit
SetVendorItemCustItemPTDYTDToZero
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery
VendorEuroCurrencyConversion

**MGR - Return Material Authorizations Group**
DeleteRMALineItemLogEntries
RMAParameters

**MGR - Shop Floor Control Group**
CADInterfaceParameters
ChangeCostRates
CompleteJobOperations
DeleteJobTransactions
DemandEDIParametersInterfaceSetup
GeneralParameters
JobandPSBillofMaterialProcessor
JobBOMCostRollUp
MultiCurrencyParameters
RebalanceItemQtyAllocatedtoJobandWIP
ShopFloorControlParameters
SupplyEDIParametersInterfaceSetup
TaxParameters
TaxSystems
TaxSystemsQuery

**Order Entry Group**
AddConsolidatedLines
AddOpportunities
AddShippingLine
AddToContactGroups
AdvanceShipNoticeLineItems
AdvanceShipNoticeLineItemsQuery
AdvanceShipNotices
AdvanceShipNoticesQuery
AvailableInventorytoReserveReport
AvailableToShipReport
BillingTerms
BillingTermsQuery
BlanketReleases
BlanketReleasesDomesticCurrency
BlanketReleasesQuery
CampaignItems
Campaigns
CampaignsQuery
CampaignStatuses
CampaignTypes
ChangeCOLineReleaseStatusUtility
ChangeCOStatusUtility
ChangeWarehouse
CommissionsDue
CommissionsDueQuery
CommissionStatusChangeUtility
CommissionTables
CommissionTablesQuery
CommodityCodes
Competitors
CompetitorsQuery
ConsolidatedInvoiceGeneration
ConsolidatedInvoicesWorkbench
ConsolidatedInvoicesWorkbenchDomesticCurrency
ConsolidatedInvoicesWorkbenchQuery
CopyCurrencyCodesandRates
CopyOrdersAndEstimates
COReturnsReasonCodes
COReturnsReasonCodesQuery
CorporateCustomerReport
CountryCodes
CreditHoldReasonCodes
CTPQuantities
CTPResults
CTPSchedule
CurrencyCodes
CurrencyCodesQuery
CurrencyRates
CurrencyRatesQuery
CustomerbyItemSalesAnalysisReport
CustomerContractPrices
CustomerContractPricesDomesticCurrency
CustomerContractPricesQuery
CustomerContracts
CustomerContractsQuery
CustomerDocProfile
CustomerDocProfileQuery
CustomerInteractions
CustomerInteractionsQuery
CustomerInteractionsReport
CustomerLettersofCredit
CustomerLettersOfCreditDomesticCurrency
CustomerLettersOfCreditQuery
CustomerOrderBlanketLines
CustomerOrderBlanketLinesDomesticCurrency
CustomerOrderBlanketLinesQuery
CustomerOrderCreditHoldSyncReport
CustomerOrderLines
CustomerOrderLinesChangeLog
CustomerOrderLinesDomesticCurrency
CustomerOrderLinesQuery
CustomerOrderListing
CustomerOrders
CustomerOrdersDomesticCurrency
CustomerOrdersforReservableItemsReport
CustomerOrdersHistorySelection
CustomerOrdersQuery
CustomerOrdersQuickEntry
Customers
CustomerSalesContactCrossReferences
CustomersDomesticCurrency
CustomersQuery
CustomerTypes
DeleteCustomerInteractions
DeleteCustomerOrders
DeleteProspectInteractions
DeleteSalesContactInteractions
DeliveryTerms
Discounts
DiscountsQuery
ECSalesListReport
EditFreightCharges
EndUserTypeReport
EndUserTypes
EndUserTypesQuery
EstimatedTotalCharges
ExciseCurrencyRates
FeatureGroupQualifiers
FeatureGroupQualifiersQuery
FeatureGroupRanks
FeatureGroupRanksQuery
FeatureGroupRerank
FeatureGroups
FeatureGroupsQuery
FeatureGroupVerification
GenerateFromPackingSlip
GenerateFromTransferOrder
GenerateOrderPickList
HistoryCommissionDistribution
HistoryCommissionDistributionQuery
HistoryCustomerOrderBlanketLines
HistoryCustomerOrderBlanketLinesDomesticCurrency
HistoryCustomerOrderBlanketLinesQuery
HistoryCustomerOrderBlanketReleases
HistoryCustomerOrderBlanketReleasesDomesticCurrency
HistoryCustomerOrderBlanketReleasesQuery
HistoryCustomerOrderLines
HistoryCustomerOrderLinesDomesticCurrency
HistoryCustomerOrderLinesQuery
HistoryCustomerOrders
HistoryCustomerOrdersDomesticCurrency
HistoryCustomerOrdersQuery
HistoryOrderShipments
IncoDeliveryTerms
InvoiceCategories
InvoiceDebitandCreditMemoSequences
InvoiceDebitandCreditMemoSequencesQuery
InvoiceRegisterbyAccountReport
InvoiceRegisterReport
ISO Country Codes
ISO Currency Codes
ISO UOM Codes
Item Availability
Item Availability Query
Item by Customer Sales Analysis Report
Item Customer Salesperson Sales Analysis Report
Item Feature Group Report
Item On Hand Quantities
Item Product Code Cost Detail Sales Analysis Report
Item Product Code Customer Sales Analysis Report
Item Sales Analysis Report
Item Sales Person Sales Analysis Report
Leads
Leads Query
Lead Statuses
Letters of Credit by Customer Report
Mailing Labels Report
Multi Lingual Order Invoice
Multi Lingual Order Invoice Query
Multi Lingual Ship Via
Multi Lingual Terms
Multi Site Customers Query
Nature of Transaction Codes
Opportunities
Opportunities Query
Opportunity Competitor Cross References
Opportunity Lost Reasons
Opportunity Member Cross References
Opportunity Sources
Opportunity Stages
Opportunity Statuses
OpportunityTasks
OpportunityTasksQuery
OpportunityTaskTypes
OpportunityWonReasons
OrderBookingsReport
OrderCostReport
OrderCreditHoldChange
OrderEntryExceptionReport
OrderPromiseDatePerformanceReport
OrderShipments
OrderShipmentsDomesticCurrency
OrderShipmentsQuery
OrderShippedCostReport
OrderShipping
OrderStatusReport
OrderVerificationReport
PackingSlip
PackingSlipDetailReport
PackingSlipQuery
PackingSlipSelection
PastDueOrderLineItemsReport
PriceAdjustmentInvoice
PriceAdjustmentInvoiceDomesticCurrency
PriceAdjustmentInvoiceTaxAdjDomCurr
PriceAdjustmentInvoiceTaxAdjustment
PriceCodes
PriceFormula
PriceFormulaDomesticCurrency
PriceFormulaQuery
PriceMatrix
PriceMatrixQuery
Pricing
PrintAdvanceShipNoticeReport
PrintPriceAdjustmentInvoice
ProductConfigurationList
ProductSalesAnalysisReport
ProgressiveBillingGeneration
ProgressiveBillingGenerationDomesticCurrency
ProgressiveBillings
ProgressiveBillingsDomesticCurrency
ProgressiveBillingsQuery
PromptForWarehouseData
ProspectInteractions
ProspectInteractionsQuery
ProspectInteractionsReport
Prospects
ProspectSalesContactCrossReferences
ProspectsQuery
ProvStates
PurchasedComponentsCrossReferenceReport
PurgePackingSlipRegisterUtility
ReprintPackingSlipReport
ReservationsforOrder
ReservationsforOrderQuery
ReservedInventorybyOrderReport
ReserveUnreserveInventoryUtility
SalesCommissionbySalespersonReport
SalesContactCommunicationWizard
SalesContactGroups
SalesContactGroupsQuery
SalesContactInteractions
SalesContactInteractionsQuery
SalesContactInteractionsReport
SalesContacts
SalesContactSalespersonCrossReferences
SalesContactsQuery
SalesForecasts
SalesForecastsQuery
SalesPeriods
SalespersonClassifications
SalespersonCommissionDistribution
SalespersonCommissionDistributionQuery
SalesPersons
SalesPersonsQuery
SalesTeamMemberCrossReferences
SalesTeams
SalesTeamsQuery
SalesValueReport
SecondaryNatureofTransactionCodes
ShipCodes
ShippedCustomerOrdersSelection
ShippedLCRsWithARemainingBalanceReport
ShippingProcessingLineReleases
ShippingProcessingLineReleasesQuery
ShippingProcessingOrders
ShippingProcessingOrdersQuery
ShipTos
ShipTosQuery
SubordinateCustomerListing
SubordinateCustomerListingDomesticCurrency
SupplementaryUnitsConversionFactorUpdate
TaxableRevenueReport
TaxCodes
TaxCodesforItemsbyJurisdiction
TaxCodesforItemsbyJurisdictionQuery
TaxCodesQuery
TaxJurisdictions
TaxJurisdictionsQuery
Territories
ToBeInvoicedReport
ToBeShippedValueReport
UnInvoicedPackingSlipsReport
WhereUsedCountryCodes
WhereUsedCustomerOrders
WhereUsedReasonCodes
WhereUsedShipViaCodes

Order Entry Hide Costs Group
EstimatedTotalCharges
InvoiceRegisterReport
ItembyCustomerSalesAnalysisReport
ItemProductCodeCostDetailSalesAnalysisReport
OrderCostReport
OrderStatusReport
ToBeShippedValueReport

Order Entry Hide Prices Group
AvailableToShipReport
BlanketReleases
BlanketReleasesDomesticCurrency
BlanketReleasesQuery
CustomerByItemSalesAnalysisReport
CustomerContractPricesDomesticCurrency
CustomerContracts
CustomerContractsQuery
CustomerOrderBlanketLines
CustomerOrderBlanketLinesDomesticCurrency
CustomerOrderBlanketLinesQuery
CustomerOrderLines
CustomerOrderLinesChangeLog
CustomerOrderLinesDomesticCurrency
CustomerOrderLinesDomesticCurrency
CustomerOrderLinesQuery
CustomerOrders
CustomerOrdersDomesticCurrency
CustomerOrdersQuery
CustomerOrdersQuickEntry
HistoryCustomerOrderBlanketLines
HistoryCustomerOrderBlanketLinesDomesticCurrency
HistoryCustomerOrderBlanketLinesQuery
HistoryCustomerOrderBlanketReleases
HistoryCustomerOrderBlanketReleasesDomesticCurrency
HistoryCustomerOrderBlanketReleasesQuery
HistoryCustomerOrderLines
HistoryCustomerOrderLinesDomesticCurrency
HistoryCustomerOrderLinesQuery
HistoryCustomerOrders
HistoryCustomerOrdersDomesticCurrency
HistoryCustomerOrdersQuery
InvoiceRegisterbyAccountReport
InvoiceRegisterReport
ItembyCustomerSalesAnalysisReport
ItemCustomerSalesPersonSalesAnalysisReport
ItemProductCodeCostDetailSalesAnalysisReport
ItemProductCodeCustomerSalesAnalysisReport
OrderCostReport
OrderEntryExceptionReport
OrderShipments
OrderShipmentsDomesticCurrency
OrderShipmentsQuery
OrderVerificationReport
Pricing
ProductSalesAnalysisReport
SalesValueReport
ToBeInvoicedReport
ToBeShippedValueReport

Order Entry Invoicing Reprint Group
ConsolidatedInvoicing
OrderInvoicingCreditMemo
ReprintProjectInvoicesReport

Payroll Group
ComputePayroll
DeductionandEarningCodes
DeductionandEarningCodesQuery
DirectDepositBanks
DirectDepositBanksQuery
DirectDepositReport
EmployeeHoursReport
EmployeeLogHoursReport
Employees
EmployeesQuery
ExportPayrollInformationtoEPI
ExternalPayrollInterfaceInput
GeneratePayroll
MagneticMediaDirectDeposit
PayrollDeductionReport
PayrollDistribution
PayrollDistributionLogReport
PayrollDistributionQuery
PayrollforPayPeriod
PayrollforPayPeriodQuery
PayrollHours
PayrollHoursQuery
PayrollLogHoursforPayPeriod
PayrollLogHoursforPayPeriodQuery
PayrollProcessing
PayrollProcessingQuery
PostedPayrollTransactionsReport
PrintPostPayrollChecks
PrintW2FormsReport
PurgeDirectDepositHistory
QuarterlybyTaxCodeReport
RetirementPlanContributionReport
TaxCodesExempt
TaxCodesExemptQuery
W2MagneticMediaElectronicFiling
W2StateFIPSNumberEntry
W2StatesToBeConsolidated
WhereUsedDirectDepositBanks
YearEndPayrollReport
YearToDateDeductionsandEarningsReport

Payroll Hide Costs Group
EmployeeHoursReport
EmployeeLogHoursReport
Employees
EmployeesQuery
PayrollHours
PayrollHoursQuery
PayrollLogHoursforPayPeriod
PayrollLogHoursforPayPeriodQuery
PostedPayrollTransactionsReport

Posting Out Of Current Period Group
For internal processing only
Project Adjustment Transaction Group
For internal processing only

Project Entry Group
Copy a project

Project Estimating Group
For internal processing only

Project Cost Rollup Group
For internal processing only

Project Labor Transaction Group
For internal processing only

Project Manager Group
For internal processing only

Project Material Transaction Group
For internal processing only

Projects Group
ChangeWarehouse
CopyProjects
CostToCompleteLogReport
CostToCompleteSnapShot
CustomerDocProfile
CustomerDocProfileQuery
DeleteProjectPackingSlipUtility
EstimateInvoiceMilestones
EstimateInvoiceMilestonesQuery
EstimateProjectResources
EstimateProjectResourcesQuery
EstimateProjects
EstimateProjectsQuery
EstimateProjectTasks
EstimateProjectTasksQuery
EstimateRevenueMilestones
EstimateRevenueMilestonesQuery
GenerateFromProject
GenerateFromProjectPackingSlip
IndentedWBSCostReport
InvoiceMilestoneNomination
InvoiceMilestoneNominationQuery
InvoiceMilestoneProgressReport
InvoiceMilestones
InvoiceMilestonesQuery
NominatedInvoiceMilestonesReport
NominatedRevenueMilestonesReport
PostProjectInvoiceMilestones
PostProjectLaborTransactions
PostProjectRetentionInvoice
PrintPostProjectRevenueMilestones
PrintPostProjectWIPRelief
PrintProjectAdvanceShipNoticeReport
ProcessProjectMilestones
ProjectAdvanceShipNoticeLineItems
ProjectAdvanceShipNoticeLineItemsQuery
ProjectAdvanceShipNotices
ProjectAdvanceShipNoticesQuery
ProjectChangeOrderLogReport
ProjectCostCodes
ProjectCostCodesQuery
ProjectInvoicingReport
ProjectJobAccumulatedCostbyPeriod
ProjectJobPeriodCosts
ProjectLaborTransactions
ProjectLaborTransactionsQuery
ProjectPackingSlip
ProjectPackingSlipSelection
ProjectParameters
ProjectPOCommitmentsReport
ProjectPreshipPackingSlip
ProjectPurchaseOrderCommitmentsReport
ProjectResources
ProjectResourceShipping
ProjectResourceShippingQuery
ProjectResourcesQuery
ProjectResourcesType
ProjectResourceTransactions
ProjectRetentionCodes
ProjectRetentionCodesQuery
ProjectRollFromForecast
Projects
ProjectsQuery
ProjectTasks
ProjectTasksQuery
ProjectTransactions
ProjectTransactionsQuery
ProjectTransactionsReport
ProjectTypes
ProjectVariancesReport
ProjectWIPAdjustments
ProjectWIPAdjustmentsQuery
ProjectWIPValuationReport
ReprintProjectInvoicesReport
ReprintProjectPackingSlipReport
RevenueMilestoneNomination
RevenueMilestoneNominationQuery
RevenueMilestoneProgressReport
RevenueMilestones
RevenueMilestonesQuery
RollUpProjectCost
SupplementaryUnitsConversionFactorUpdate
UnpostedProjectLaborTransactionsReport
WBSPercentCompleteReport
WhereUsedEstimateProjectTasks
WhereUsedProjectCostCodes
WhereUsedProjectTasks
WhereUsedProjectTypes
WorkBreakdownStructure
WorkBreakdownStructureQuery

Projects Cost Group
ProjectMarginAnalysisReport
ProjectWIPValuebyAccountReport

Projects Hide Costs Group
CostToCompleteLogReport
EstimateProjectResources
EstimateProjectResourcesQuery
EstimateProjects
EstimateProjectsQuery
EstimateProjectTasks
EstimateProjectTasksQuery
EstimateRevenueMilestones
EstimateRevenueMilestonesQuery
NominatedInvoiceMilestonesReport
PostProjectLaborTransactions
ProjectLaborTransactions
ProjectLaborTransactionsQuery
ProjectPurchaseOrderCommitmentsReport
ProjectResources
ProjectResourcesQuery
ProjectResourceTransactions
Projects
ProjectsQuery
ProjectTasks
ProjectTasksQuery
ProjectTransactionsReport
ProjectWIPAdjustments
ProjectWIPAdjustmentsQuery
RevenueMilestoneNomination
RevenueMilestoneNominationQuery
RevenueMilestones
RevenueMilestonesQuery
UnpostedProjectLaborTransactionsReport

Purchase Requisitions Group
ChangePORequisitionLineStatus
DeletePORequisitionLines
PORequisitionReport
PurchaseOrderRequisitionCodes
PurchaseOrderRequisitionLines
PurchaseOrderRequisitionLinesQuery
PurchaseOrderRequisitions
PurchaseOrderRequisitionsQuery
PurchaseRequisitionReport
RequisitionPOComparisonReport
WhereUsedPurchaseOrderRequisitionCodes

Purchase Requisitions Hide Costs Group
PORequisitionReport
PurchaseOrderRequisitionLines
PurchaseOrderRequisitionLinesQuery
PurchaseOrderRequisitions
PurchaseOrderRequisitionsQuery
PurchaseRequisitionLines
PurchaseRequisitionLinesQuery
PurchaseRequisitionReport
PurchaseRequisitions
PurchaseRequisitionsQuery
RequisitionPOComparisonReport

Purchase Requisitions Approval Group
ChangePORequisitionLineStatus

Purchasing Group
AddPO
AddReceivingLine
AddSingleByPoLines
BillingTerms
BillingTermsQuery
BuilderPurchaseOrderReport
ChangeOrderDetailReport
ChangePOLineReleaseStatusUtility
ChangePOStatusUtility
ChangeWarehouse
ConvertPORequisition
CopyPurchaseOrders
CountryCodes
DeletePurchaseOrders
DeleteVendorInteractions
DeliveryTerms
DropShipTo
DropShipToQuery
ECSSDs
ECSSDsDomesticCurrency
ECSSDsQuery
GenerateAPTransactions
GenerateAPTransactionsDomesticCurrency
GenerateLandedCostVouchers
GetPoLineReleases
GSTInputTaxCreditReport
HistoryPurchaseOrderBlanketLineReleases
HistoryPurchaseOrderBlanketLines
HistoryPurchaseOrderBlanketLinesDomesticCurrency
HistoryPurchaseOrderBlanketLinesQuery
HistoryPurchaseOrderBlanketReleasesDomesticCurr
HistoryPurchaseOrderBlanketReleasesQuery
HistoryPurchaseOrderLandedCosts
HistoryPurchaseOrderLandedCostsDomesticCurrency
HistoryPurchaseOrderLandedCostsQuery
HistoryPurchaseOrderLined
HistoryPurchaseOrderLinesDomesticCurrency
HistoryPurchaseOrderLinesQuery
HistoryPurchaseOrderReceipts
HistoryPurchaseOrders
HistoryPurchaseOrdersDomesticCurrency
HistoryPurchaseOrdersQuery
IncoDeliveryTerms
LandedCostVarianceReport
LettersofCreditbyVendorReport
MaterialTransactionsReport
MultiLingualPurchaseOrders
MultiLingualPurchaseOrdersQuery
MultiLingualShipVia
MultiLingualTerms
MultiSiteVendors
MultiSiteVendorsQuery
NatureofTransactionCodes
PastDuePurchaseOrderReport
PaymentHoldReasons
POChangeOrders
POChangeOrdersQuery
POLandedCostAllocation
POReceivingList
POVoucherRegisterbyAccountReport
ProvStates
ProvStatesQuery
PSTInputTaxCreditReport
PurchaseOrderBlanketLines
PurchaseOrderBlanketLinesDomesticCurrency
PurchaseOrderBlanketLinesQuery
PurchaseOrderBlanketReleases
PurchaseOrderBlanketReleasesDomesticCurrency
PurchaseOrderBlanketReleasesQuery
PurchaseOrderBuilder
PurchaseOrderBuilderPlanningFilter
PurchaseOrderHistorybyVendorReport
PurchaseOrderLandedCosts
PurchaseOrderLandedCostsDomesticCurrency
PurchaseOrderLandedCostsQuery
PurchaseOrderLines
PurchaseOrderLinesBlanketReleasesQuery
PurchaseOrderLinesDomesticCurrency
PurchaseOrderLinesQuery
PurchaseOrderListing
PurchaseOrderReceipts
PurchaseOrderReceiptsDomesticCurrency
PurchaseOrderReceiving
PurchaseOrderResetAccumulativeTotalsUtility
PurchaseOrderReturnReasonCodes
PurchaseOrderReturnReasonCodesQuery
PurchaseOrders
PurchaseOrdersDomesticCurrency
PurchaseOrdersQuery
PurchaseOrdersQuickEntry
PurchaseOrderStatusReport
PurchaseRequirementsReport
PurchasingParameters
RanksForItem
RecentPurchasesReport
RequisitionPOComparisonReport
SecondaryNatureofTransactionCodes
ShipCodes
SupplementaryUnitsConversionFactorUpdate
TaxCodesForItemsByJurisdiction
TaxCodesForItemsByJurisdictionQuery
TaxJurisdictions
TaxJurisdictionsQuery
TaxPayableReport
TaxVouchered(Parametric)Report
TaxVouchered-ParametricReport
TransferOrderItemXRefProcessing
VendorCategories
VendorCategoriesQuery
VendorContractPrices
VendorContractPricesDomesticCurrency
VendorContractPricesQuery
VendorContracts
VendorContractsDomesticCurrency
VendorContractsQuery
VendorDocProfile
VendorDocProfileQuery
VendorInquiryDomesticCurrencyPurchaseOrder
VendorInteractions
VendorInteractionsQuery
VendorInteractionsReport
VendorLettersofCredit
VendorLettersofCreditDomesticCurrency
VendorLettersofCreditQuery
Vendors
VendorsQuery
VoucherAuthorization
VoucherAuthorizationReport
VoucherBuilder
VoucherBuilderDomesticCurrency
VoucherRegisterReport
WhereUsedDropShipTo
WhereUsedProv/State
WhereUsedPurchaseOrderRequisitionCodes

Purchasing Costs Group
ChangeOrderReport
POFundsCommittedReport
PurchaseOrderReport
PurchaseOrderVariancebyItemReport
VouchersPayableReport

Purchasing Hide Costs Group
ChangeOrderDetailReport
HistoryPurchaseOrderBlanketLineReleases
HistoryPurchaseOrderBlanketLines
HistoryPurchaseOrderBlanketLinesDomesticCurrency
HistoryPurchaseOrderBlanketLinesQuery
HistoryPurchaseOrderBlanketReleasesDomesticCurr
HistoryPurchaseOrderBlanketReleasesQuery
Return Material Authorizations Group
AddRmaReturnLine
CustomerDocProfile
CustomerDocProfileQuery
DispositionCodes
EvaluationCodes
ProblemCodes
PurgeHistoryRMAs
RMACreditMemo
RMACreditMemoPrintPostReport
RMALineItems
RMALineItemsDomesticCurrency
RMALineItemsQuery
RMAReturnReasonCodes
RMAReturnReasonCodesQuery
RMAReturnTransaction
RMAs
RMAsDomesticCurrency
RMAsQuery
RMAStatusReport
RMAVerificationReport
SupplementaryUnitsConversionFactorUpdate
WhereUsedDispositionCodes

Return Material Authorizations Hide Costs Group
For internal processing only

Shop Floor Control Group
APSOderPriority
BatchDefinitionOperations
BatchDefinitionOperationsQuery
BatchDefinitions
BatchDefinitionsQuery
BatchedProductionOperationsQuery
BatchedProductions
BatchedProductionsQuery
BatchProductionOperations
BatchSummary
BatchSummaryQuery
BOMImportBuilder
BOMListing
ChangeBatchProdStatusUtility
ChangeMaterialSequence
ChangeProductionScheduleReleaseStatusUtility
ChangeWarehouse
ConsolidatedJobCostReport
CoproductJobOrders
CoproductJobOrdersQuery
CopyProductionSchedules
CreateBatchProdUtility
CumulativeProductionbyItemReport
CurrentJobCostVarianceReport
DeleteBillofMaterialComponents
DeleteEndofPeriodCostingTransactions
DeletePendingJobLaborTransactions
DeletePendingMaterialTransactions
DeleteProductionScheduleReleases
DeleteShiftExceptions
DemandDetailScheduler
DemandSummaryScheduler
Departments
DepartmentsQuery
EndofPeriodCosting
EngineeringWorkbench
EngineeringWorkbenchFilterCurrent
EngineeringWorkbenchFilterEstimate
EngineeringWorkbenchFilterJob
EngineeringWorkbenchFilterProductionSchedule
EngineeringWorkbenchFilterPSRelease
EngineeringWorkbenchFilterStandard
ExportRoutingBOM
FloorStockReplenishmentReport
GenerateCoproductMixCostDistributionandRouting
GenerateProductionSchedules
GlobalPrioritySetting
Holidays
IndirectLaborCodes
IndirectLaborCodesQuery
JobBOMReport
JobCostDetailBreakoutReport
JobCostReport
JobCostToCompleteReport
JobLotMerging
JobLotSplitting
JobMaterials
JobMaterialsListing
JobMaterialsQuery
JobMaterialTransactions
JobOperations
JobOperationsQuery
JobOperationStatusReport
JobOrders
JobOrdersQuery
JobPacket
JobPickList
JobStatusChangeDeleteUtility
JobTransactionsReport
JustInTimeProductionTransactions
LaborAnalysisbyWorkCenterReport
MaterialAnalysisbyWorkCenterReport
MaterialTransactionsbyJobOrder
PastDueJobOperationsReport
PastDueJobsReport
PendingJobLaborTransactions
PendingJobLaborTransactionsQuery
PendingJobLaborTransactionsReport
PendingMaterialTransactions
PendingMaterialTransactionsQuery
PendingMaterialTransactionsReport
PostedJobTransactionsListing
PostJobTransactions
PostJobWIPMoveTransactions
PostPendingJobLaborTransactions
PostPendingMaterialTransactions
ProductionCostbyWorkCenterReport
ProductionExceptionsReport
ProductionScheduleCompleteTransactions
ProductionScheduleEarnedCostReport
ProductionScheduleItems
ProductionScheduleItemsQuery
ProductionScheduleMaterials
ProductionScheduleMaterialsQuery
ProductionScheduleOperations
ProductionScheduleOperationsQuery
ProductionScheduleOperationStatusReport
ProductionScheduleReleaseMaterials
ProductionScheduleReleaseMaterialsQuery
ProductionScheduleReleaseOperations
ProductionScheduleReleaseOperationsQuery
ProductionScheduleReport
ProductionScheduleRoutingReport
ProductionSchedules
ProductionScheduleScrappedReport
ProductionScheduleScrapTransactions
ProductionSchedulesQuery
ProductionScheduleTransactionReport
ProjectedItemCompletionsbyResourceGroupReport
ProjectedItemCompletionsbyResourceReport
ProjectedItemCompletionsReport
PromptForWarehouseData
RemoveBatchProdUtility
ResourceDispatchListReport
ResourceFinalQueueReport
ResourceGanttChart
ResourceGroupDispatchListReport
ResourceGroupFinalQueueReport
ResourceGroupLoadProfile
ResourceGroupQueue
ResourceGroups
ResourceGroupSchedule
ResourceGroupScheduleQuery
ResourceGroupSequencing
ResourceGroupsQuery
ResourceGroupSummaryReport
ResourceGroupUtilization
ResourceLoadProfile
ResourceQueue
Resources
ResourceSchedule
ResourceScheduleQuery
ResourceSequencing
ResourcesQuery
ResourceSummaryReport
ResourceTypes
ResourceUtilization
Scheduling
ScrapAnalysisReport
ScrapReasonCodes
SeparationAttributes
SetupGroups
SetupMatrix
ShiftCodes
ShiftCodesQuery
ShiftExceptionsbyGroup
ShopCalendars
ShopCalendarsQuery
UnpostedJobTransactions
UnpostedJobTransactionsListing
UnpostedJobTransactionsQuery
UpdateSchedule
WhereUsedIndirectLaborCodes
WhereUsedJobOrders
WhereUsedResourceGroups
WhereUsedResources
WhereUsedShopCalendars
WorkCenterDetailScheduleLoad
WorkCenterLaborTransactions
WorkCenterMachineTimeTransactions
WorkCenterMaterialTransactions
WorkCenters
WorkCentersQuery
WorkCenterTransactionsReport
WorkCenterWhereUsedReport

Shop Floor Control Costs Group
IndentedProjectedJobCosttoCompleteReport
JobCostbyItemReport
JobCostDetailStatusReport
JobCostVarianceReport
JobExceptionReport
ProjectedJobCosttoCompleteReport
TotalWipValuebyAccountReport
WipValuationReport

Shop Floor Control Hide Costs Group
Departments
DepartmentsQuery
EmployeeVarianceReport
JobMaterials
JobMaterialsQuery
JobMaterialTransactions
JobOperations
JobOperationsQuery
JobOrders
JobOrdersQuery
JobTransactionsReport
ProductionScheduleEarnedCostReport
ProductionScheduleMaterials
ProductionScheduleMaterialsQuery
ProductionScheduleOperations
ProductionScheduleOperationsQuery
UnpostedJobTransactions
UnpostedJobTransactionsQuery
WorkCenterMaterialTransactions
WorkCenters
WorkCentersQuery
WorkCenterTransactionsReport

Standard Forms Group
BackgroundQueue
Calculator
ChangePassword
ClassNotes
Authorizations

CreateUserAppointment
CreateUserTask
GetOptions
Inbox
InstalledProductBase
Notes
ObjectNotes
ReportOptions
ReportOutputFiles
ReportViewer
SavedMessages
SendMessage
StdGraphDefinition
StoreOptions
SystemUserNotes
TaskList
UserCalendar
WebBrowser

System Administration Group
AccessAs
ActiveBGTasks
ActiveWorkflows
ApplicationSchemaColumnsMetadata
ApplicationSchemaModulesMetadata
ApplicationSchemaTablesMetadata
ApplicationSchemaTablesMetadataExtensions
APSSizingReport
AuditLog
AuditLogTypes
AuthorizationGroups
AuthorizationUsers
BackgroundQueue
BackgroundQueueSetup
BGTaskDefinitions
BGTaskDefinitionsQuery
BGTaskHistory
BGTaskHistoryQuery
BudgetConsolidation
Calculator
CentralizedSqlClr
ChangePassword
ChangeReportsToEntity
ChangeSite
ClearUserSessions
ComponentAuthorizationGroups
ComponentAuthorizationUsers
CrashRecovery
CreateUserAppointment
DatabaseFiles
DatabaseSchemaReport
DateManagement
DeleteAuditLogs
DomesticEuroCurrencyConversion
EventActionAchieveMilestone
EventActionAudit
EventActionBranch
EventActionCallDatabaseMethod
EventActionCallIdoMethod
EventActionCallWebService
EventActionChoicesEditor
EventActionDispatchIdoRequest
EventActionExecIdoRequest
EventActionExpressionEditor
EventActionFail
EventActionFinish
EventActionGenerateEvent
EventActionGoto
EventActionLoadCollection
EventActionLoadIdoRow
EventActionNotify
EventActionOutputParametersEditor
EventActionParameterCondition
EventActionParameterProperties
EventActionParameterRecipients
EventActionParameters1Editor
EventActionParameters2Editor
EventActionPrompt
EventActionRunBackgroundTask
EventActions
EventActionSendEmail
EventActionSetAttributes
EventActionSetResultsetIdEditor
EventActionSetResultVarEditor
EventActionSetValues
EventActionSetValuesEditor
EventActionSleep
EventActionTransformXml
EventActionUpdateCollection
EventActionWait
EventGlobalConstants
EventHandlerDiagram
EventHandlerRevisionDiagram
EventHandlerRevisions
EventHandler
EventHandlers
EventHandlerStatus
EventMessageCategories
EventQueue
Events
EventStatus
EventTriggers
EventVariableGroups
ExternalFinancialInterfaceParameters
ExtSystemTransLogs
FindReplSetUpIssue
FixedAssetParameters
FixedAssetYearEndProcedure
GeneralParameters
GenerateAppSchemaMetadataExtScript
GenerateAppSchemaMetadataScripts
GetOptions
GroupsMaint
GroupsMaintQuery
IdoAdditionalListProperties
IdoAdvancedAttributes
IDOAliases
IdoCollections
IdoCustomAssemblies
IdoExportWizard
IdoImportWizard
IdoLinkByEditor
IdoMassageProperties
IdoMethods
IdoMethodWizard
IdoProjects
IdoProperties
IdoPropertyClasses
IdoPropertyWizard
IdoTableBindProperties
IdoTables
IdoTableWizard
IdoWizard
InterSiteParameters
InterSiteParametersQuery
Intranets
IntranetSharedTables
IntranetSharedUserTables
IntranetsQuery
LanguageIDs
LanguageIDsQuery
LedgerConsolidation
LicensedModules
LicenseManagement
LicenseModuleConnectedUsers
LicenseModuleUserCounts
ManualReplicationUtility
MoveLocalCustomers
MoveLocalVendors
MoveProspectToCustomer
MultiCurrencyParameters
OptionsDefaults
OptionsDefaultsQuery
OutlookPublicFolderBrowser
PasswordParameters
Printers
ProcessDefaultNames
ProcessDefaults
PurgeJournals
QuickDictionaryReport
ReplDocAttributes
ReplDocAttributesQuery
ReplDocElements
ReplDocElementsQuery
ReplDocInboundCrossReferences
ReplDocInboundCrossReferencesQuery
ReplDocInbox
ReplDocManualRequestUtility
ReplDocOutboundCrossReferences
ReplDocOutboundCrossReferencesQuery
ReplDocOutbox
ReplDocuments
ReplDocumentsQuery
ReplicationCategories
ReplicationCategoriesQuery
ReplicationErrors
ReplicationManagement
ReplicationRules
ReplicationRulesQuery
RunningWorkFlows
SessionAccessAs
SessionManagement
SetDefaultWarehouse
SetLedgerConsolidatedFlag
SiteEntities
SiteEntitiesQuery
SiteGroups
SqlColumms
SqlTables
SqlTablesPrimaryKey
StartupMethods
StdGraphDefinition
StoreOptions
SuspendedUpdates
SynchronizeNextKeys
SystemConfigurationParameters
SystemParameters
SystemTypes
SyteLineCalculator
TaskExclusion
TaskList
TaskTypes
TaskTypesQuery
TriggerManagement
UETClasses
UETClassesQuery
UETClassFieldRelationships
UETClassFieldRelationshipsQuery
UETClassIndexRelationships
UETClassIndexRelationshipsQuery
UETCopyField
UETImpactSchema
UETRuleAssistant
UETTableClassRelationships
UETTableClassRelationshipsQuery
UETUserFields
UETUserFieldsQuery
UnlockLockedFunctions
UnlockLockedJournals
Update_AllTables
UserCalendar
UserClassReport
UserDefinedTypes
UserDefinedTypesQuery
UserDefinedTypeValues
UserDefinedTypeValuesQuery
UserFieldsReport
UserIndexReport
UserModules
UserModulesQuery
UsersMaint
UsersMaintQuery
WebBrowser
WorkFlowsQuery
WorkflowTemplates
To get everything working properly again in the event of a system crash, you may have to do any or all of the following:

- Unlock locked functions
- Unlock locked journals
- Recover locked tokens.

You can go to the individual forms mentioned above or you can run the Crash Recovery utility. It is not always necessary to run the Crash Recovery utility. Read the following information for details about when to run this utility.

Crash Recovery Utility

Use this utility to clear user session information for all users except the user running this utility, unlock all locked functions and journals, and clear two DC parameters. You would most commonly need to run this utility following a crash of the utility server, but you can run it anytime.

You do not need to run this utility following a database server crash. The functions of this utility are performed automatically when the database server is rebooted.

NOTE: Any users still logged in are kicked out of the system when you run this utility. DO NOT run this utility against a database that is still being accessed by users.
Unlock Locked Functions

A function is locked for one of two reasons:
1) the function is currently being performed; or 2) it was terminated prior to normal completion. This operation is used to unlock a function when the latter case has occurred.

<table>
<thead>
<tr>
<th>Description</th>
<th>Locked</th>
<th>Locked By</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORDER ENTRY INVOICING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PAYROLL POSTING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INVENTORY POSTING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHECK PROCESSING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FIXED ASSETS POSTING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCHEDULING</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHART OF ACCOUNTS ALLOC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRINTING FINANCIAL STMTS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>POSTING JOURNALS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If the Locked field is selected next to the function, it is locked. If the Locked field is cleared next to the function, it is unlocked.

Use the Unlock Locked Functions utility to unlock functions that were somehow aborted prior to normal termination. If a Locked message displays when you enter certain processes, use this utility to unlock it.
Unlock Locked Journals

A journal is locked for one of two reasons:
1) It is currently being edited, posted into, or posted; or
2) One of these operations was terminated prior to normal completion.
This operation is used to unlock a journal when the latter case has occurred.

<table>
<thead>
<tr>
<th>Journal</th>
<th>Description</th>
<th>Locked</th>
<th>Locked By</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Dist</td>
<td>Accounts Payable Ledger Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR Dist</td>
<td>Accounts Receivable Ledger Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNK Dist</td>
<td>Banking Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CD Dist</td>
<td>Order Entry Ledger Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FA Dist</td>
<td>Fixed Assets Ledger Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>General Journal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IC Dist</td>
<td>Inventory Control Ledger Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INV Dist</td>
<td>Inventory Ledger Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multi Site</td>
<td>Multi Site Journal</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If the Locked field is selected next to the journal, it is locked. If the Locked field is cleared next to the journal, it is unlocked.

Use the Unlock Locked Journals utility to unlock journals that are locked as a result of one of the following operations being terminated prior to normal completion:

- editing a journal
- posting information into a journal
- posting a journal
Recover Locked Tokens

If Infor ERP SyteLine terminates unexpectedly, it is possible that license tokens in use at the time are locked, thus preventing users from logging in. In this case, use the Session Management form to free up the locked tokens. See the online help for more information about the Session Management form.
Setting up an Audit Log

Use the audit log to see which user performed what action at what time and on what form.

Use the following three forms to manage your audit logging:

- Process Defaults
- Audit Log Types
- Audit Log.

Process Defaults

Use the **Process Defaults** form to enable audit logging.

<table>
<thead>
<tr>
<th>Default Name</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Check metadata linkage</td>
<td>Server=&gt;ssrdbandlat</td>
</tr>
<tr>
<td>2. Message Bus Dispatch Buffer</td>
<td>info bus require MailBusRouter</td>
</tr>
<tr>
<td>3. Number of Deadlock Retry Attempts</td>
<td>0</td>
</tr>
<tr>
<td>4. Flatfile/EdiNo Table Locks</td>
<td>0</td>
</tr>
<tr>
<td>5. Journal Posting No Table Locks</td>
<td>0</td>
</tr>
<tr>
<td>6. Collection Read Mode</td>
<td>UNCOMMITTED</td>
</tr>
<tr>
<td>7. Report Package Size</td>
<td>DEFAULT</td>
</tr>
<tr>
<td>8. Lock Job Item</td>
<td>0</td>
</tr>
<tr>
<td>9. Enable Audit Logging</td>
<td>0</td>
</tr>
<tr>
<td>10. WinAudit Max Record Count</td>
<td>0</td>
</tr>
</tbody>
</table>

Set the Default Value field to **1** for Enable Audit Logging. A default value of **0** turns the audit log functionality off.
Audit Log Types

Use the **Audit Log Types** form to create types of messages to include in the audit log. By default, the system generates messages when users log on (type 1) and when users open a form (type 2). Developers can create other types of messages that are generated by event handlers of the Add Entry to Audit Log response type.

The **Audit Log Types** form displays the following information:

- **Message Type** - The Message Type field indicates the type of message in the audit log. By default, messages about users logging on are 1, and messages about users opening forms are 2. Message Type other than 1 or 2 is a custom message.
- **Category** - Category identifies the type of auditing. Three values can appear in this field:
  - **System** - Types of events are User Login and Open Form. You cannot select a category of System.
  - **Custom Form Event** - Custom Form Event allows programmers to add audit logging to any event handler; for example, when a user selects a tab on a form.
  - **Database** - Database displays when records are added, updated, and deleted, and the message displays 1) Database: Add, 2) Database: Update, or 3) Database: Delete, depending on the action performed.
- **Table or Description** - For System and Custom Form Events, this field describes the event being logged. You can change the contents of this field at any time. The value in this field appears in the Audit Log.
  
  For Category Database, this field indicates the table that will have an audit log.

- **Fields** - Fields is used only if the category is Database. This can be a specific database field (cust_num, for example) or an asterisk (*). Entry of an asterisk indicates that all fields in the table should be entered in the audit log.
Audit Log

Use the Audit Log form to view and delete messages in the audit log.

The Audit Log form displays the following information:

- **Log Description** - This field describes the type of audit log. For example, if you opened the Purchase Order Lines form, the Log Description lists the form name "PurchaseOrderLines".

- **Message Type** - This field indicates the type of message in the audit log. By default, messages about users logging on are 1, and messages about users opening forms are 2. Message Type other than 1 or 2 is a custom message.

- **Category** - Category identifies the type of auditing. Three values can appear in this field:
  - **System** - Types of events are User Login and Open Form. You cannot select a category of System.
  - **Custom Form Event** - Custom Form Event allows programmers to add audit logging to any event handler; for example, when a user selects a tab on a form.
  - **Database** - Database displays when records are added, updated, and deleted, and the message displays 1) Database: Add, 2) Database: Update, or 3) Database: Delete, depending on the action performed.

- **Message Description** - The message description is a description of the message type. The description will be one of three values:
  - **User Login**
  - **Open Form**
  - **Custom Message**

- **Primary Key** - Primary Key identifies the database record being changed. It contains the fields that make up the primary key. When multiple fields make up a key, the values are concatenated and separated by dashes. For example, Purchase Order P000000001 Line 5 Release 2 appears as P000000001-5-2.
- **Old Value** - Old Value is only used for Category Database. Based on the activity - Add, Update, or Delete - the following is displayed:
  - **Add**: Blank
  - **Update**: Value prior to update
  - **Delete**: Value prior to delete.

- **New Value** - New Value is only used for Category Database. Based on the activity - Add, Update, or Delete - the following is displayed:
  - **Add**: Value after the add
  - **Update**: Value after the update
  - **Delete**: Blank.

- **User Name** - The user ID whose actions generated the audit log message is displayed.

- **Date/Time** - Date/Time displays the system date and time that the audit log entry was made.
Improving Performance

This chapter presents information on how to improve the performance of your system. In general, techniques for improving performance are designed to reduce unnecessary processing, network traffic, and blocking. The techniques minimize:

- The number of unneeded records stored in tables
- The number of records retrieved in queries
- The number of locks on records in queries
- The duration of locks on records
- The size and duration of transactions
- The fragmentation of tables and indexes.
- Avoiding timeouts.

For information on customization and performance, see the document *Modifying Infor ERP SyteLine*.

Hardware

You must have appropriate hardware to meet the demand put on your system. Refer to the *Guide to Technology* for minimum requirements.

- **Server usage** - Our recommended server usage is detailed in the Introduction chapter of the Infor ERP SyteLine *Installation Guide*.
- **Transaction log drives vs. data drives** - Use separate physical drives for the data and log files. Because transaction logs are written sequentially, they require fewer dedicated drives than do data files. The number of physical drives, capacity, and performance are more important for the data drives than for the transaction log drives.

SQL Server Settings

SQL *requirements* are listed at the beginning of each chapter in this guide where appropriate. This section includes some settings that can be used for a performance improvement. Refer to SQL documentation for more information.
Auto Shrink - On the application database machine, always have **Auto shrink** disabled for all databases. If it is disabled, your system will not show significant performance loss related to shrinking the database. If it is enabled, SQL Server checks every 30 minutes to see if it needs to shrink the database; this can cause a huge performance hit. You can use the DBCC SHRINKDATABASE or DBCC SHRINKFILE commands when you need to shrink databases, or you can use the SQL Server Agent to schedule regular file-shrinking instead of enabling **Auto shrink**.

Auto update statistics - We recommend that you enable **Auto update statistics** for all databases. This feature is enabled by default. With this feature enabled, SQL Server updates the statistics of an index based on the following criteria:

- If the number of rows in a table is greater than 6, but 500 or less, statistics are updated when there have been 500 modifications made, OR
- If the number of rows in the table is greater than 500, updates are made when 500 plus 20% of the number of rows in the table have been modified.

When a SQL Server database is under very heavy load, this feature can update the statistics during busy times, causing a performance issue. If you find that enabling the feature causes more problems than it solves, you can turn it off, and then manually update the statistics when the database is under a less heavy load.

We recommend that you both enable **Auto update statistics** and update statistics manually. See “Update Statistics” on page 158.

Tempdb - Set the original size of the tempdb database files to a reasonable size (about the size of the ledger table) to prevent the files from automatically expanding as more space is needed. If the tempdb database expands too frequently, performance can be affected. Set the file-growth increment percentage to a reasonable size (10% is a good choice) to avoid the tempdb database files from growing by too small a value. If the file growth is too small compared to the amount of data being written to the tempdb database, then tempdb may need to constantly expand, thereby affecting performance. Place the tempdb database on a fast I/O subsystem to ensure good performance. Stripe the tempdb database across multiple disks for better performance. Use filegroups to place the tempdb database on disks different from those used by user databases.

Minimum server memory and Maximum server memory - Set these values based on the size and activity of your instance of SQL Server.

MAXDOP - Set the max degree of parallelism option to 8 or less by using sp_configure.

### Unneeded Data

Unneeded data in tables with a large number of records can increase query time and slow certain processes. Infor ERP SyteLine provides utilities for reducing unneeded data. SQL Server system stored procedures aid in understanding table size.

#### Purge or Compress Unneeded Data

The following forms allow you to purge or compress data to improve performance. Determining when to use these forms is primarily a business decision you need to make.
We’ve made recommendations for some listed below. Refer to the online Help for information on how to use the forms.

It is important to formulate a data retention plan for each area. You should decide how long to retain data and who will purge or compress records that are older than the planned retention period.

- **Compress General Ledger Transactions**
- **Delete Material Transactions** - Do this as part of year-end procedures.
- **Delete Job Transactions**
- **Delete A/P Posted Transactions**
- **Activate/Deactivate Posted Transactions - A/P**
- **Delete A/R Posted Transactions**
- **Activate/Deactivate Posted Transactions - A/R**
- **Delete Audit Logs**
- **Audit Log Types** - Look at the types you have on this form and verify that you need all the ones you have created. Types 1 and 2 are standard default types, and you cannot delete them. All other types (10,000 and above) are custom types created by you. You can delete these types.

### Examine Table Size

The SQL Server system stored procedure `sp_spaceused` reports information about a table that can be useful in forming and implementing a data retention plan. The stored procedure shows:

- Number of rows in a table
- Space reserved for a table
- Space used by data in a table
- Space used by the index in a table
- Unused space in a table

In SQL Query Analyzer, with the Infor ERP SyteLine application database selected as the current database, use the following syntax to generate a report on a table:

```
EXEC sp_spaceused table_name
```

Example:

```
EXEC sp_spaceused ledger
```

To report on tables that are likely to need attention in a data retention plan, you can use the following script:

```
-- Ledger
EXEC sp_spaceused ledger
EXEC sp_spaceused ledger_all

-- Material Transaction
EXEC sp_spaceused matltran
EXEC sp_spaceused matltran_all
```
EXEC sp_spaceused matltran_amt
EXEC sp_spaceused matltran_amt_all

-- Job Transactions
EXEC sp_spaceused jobtran

-- AR Transactions
EXEC sp_spaceused artran
EXEC sp_spaceused artran_all

-- AP Transactions
EXEC sp_spaceused aptrxpx
EXEC sp_spaceused aptrxpx_all

-- Audit Logs
EXEC sp_spaceused AuditLog

To report on all tables in the database, you can use this script:

DECLARE @table_name sysname
DECLARE Tables_Cursor CURSOR FOR
SELECT name
FROM sysobjects
WHERE type = 'U' ORDER BY 1

OPEN Tables_Cursor
FETCH NEXT FROM Tables_Cursor INTO @table_name
WHILE @@FETCH_STATUS = 0
BEGIN
    EXEC sp_spaceused @table_name
    FETCH NEXT FROM Tables_Cursor INTO @table_name
END

CLOSE Tables_Cursor
DEALLOCATE Tables_Cursor

To select tables with similar names, modify the WHERE clause in the script. For example, to report on only tables with the _all suffix, replace

WHERE type = 'U' ORDER BY 1

with

WHERE type = 'U' AND name LIKE '%[_]all' ORDER BY 1

See the Help for SQL Server for more information about sp_spaceused.
Filter Inactive Records in Data Integration

Data integration between this system and other products may require the transfer of a large number of records with each update. Some records that are maintained in this system are not required in integration with these programs. You can improve performance by excluding them.

You can modify a product to filter out specified customer, vendor, and item records. To specify a record to be filtered, clear the field **Active for Data Integration** for the record in the Customers, Vendors, or Items form. By default, the field is selected for each record, and the record is replicated and synchronized with the other products.

SQL Server Maintenance

SQL Server statistics that are out of date and tables and indexes that are significantly fragmented adversely affect system performance. You can monitor their condition and take steps to enhance their performance.

Statistical Information

SQL Server uses statistical information about the distribution of values in a column to determine the optimal strategy for evaluating a query. Distribution statistics help the system estimate how efficient an index would be in retrieving data associated with a key value or range specified in the query.

As the data in a column changes, index and column statistics can become out-of-date, affecting query performance. The statistics should be refreshed anytime significant numbers of changes to keys occur in the index.

We recommend that you update statistics nightly or weekly for best performance (see “Update Statistics” on page 158).

You can use the **dbcc show_statistics** statement to generate a report on the distribution statistics for an index. The statements in this section use the following syntax:

```
    dbcc show_statistics (table_name, index_name)
```

In SQL Server Management Studio, with the application database selected as the current database, the following statements show the current statistics and the last time statistics were updated for primary keys in major tables:
dbcc show_statistics (item, pk_item)
dbcc show_statistics (customer, pk_customer)
dbcc show_statistics (ledger, pk_ledger)
dbcc show_statistics (matltran, pk_matltran)
dbcc show_statistics (matltran_amt, pk_matltran_amt)
dbcc show_statistics (journal, pk_journal)
dbcc show_statistics (ledger_all, pk_ledger_all)

The results indicate the selectivity of an index (the lower the density returned, the higher the selectivity) and provide the basis for determining whether an index is useful in optimizing queries.

See SQL Server Help for dbcc show_statistics and other DBCC (Database Console Commands) statements.

Update Statistics

Use the Transact-SQL statement UPDATE STATISTICS if

- A process suddenly takes much longer than usual to run
- There is a significant change in the key values in an index
- A large amount of data in an indexed column has been added, changed, or removed, or the table has been truncated using the TRUNCATE TABLE statement and then repopulated.

We recommend that you update statistics nightly or weekly.

This example updates the statistics for all indexes on the customer table.

```
UPDATE STATISTICS customer
```

To update statistics for all tables in the in the current database, you can run the SQL Server stored procedure sp_updatestats, which uses UPDATE STATISTICS:

```
EXEC sp_updatestats
```

For more information, see SQL Server Help for UPDATE STATISTICS and sp_updatestats.

Fragmentation Information

Fragmentation occurs through data modifications (INSERT, UPDATE, and DELETE). For queries that scan part or all of a table, this fragmentation can cause additional pages to be read, adversely affecting performance.

You can use the Transact-SQL DBCC SHOWCONTIG statement to display fragmentation information for the data and indexes of a specified table.

To determine whether a table is heavily fragmented, use the following syntax in SQL Query Analyzer, with the application database selected as the current database:

```
DBCC SHOWCONTIG (table_name)
```

In the result set, the value of Logical Scan Fragmentation gives an indication of the table's fragmentation level. The value should be close to zero, although a value from 0% through 10% may be acceptable.
To show in a grid an abbreviated result set for every index on every table, use:

DBCC SHOWCONTIG WITH TABLERESULTS, FAST

To show the full result set for every index on every table, use:

DBCC SHOWCONTIG WITH TABLERESULTS, ALL_INDEXES

For more information, see SQL Server Help for DBCC SHOWCONTIG.

Defragment Indexes

We recommend that you rebuild your table indexes on a weekly basis if possible.

The Transact-SQL DBCC INDEXDEFRAG statement defragments indexes of a specified table, improving index-scanning performance.

DBCC INDEXDEFRAG (database_name, table_name, index_name)

The script below uses DBCC INDEXDEFRAG and DBCC SHOWCONTIG to defragment all indexes in a database fragmented above a declared threshold of 30 percent. The script is from Microsoft’s Transact-SQL Reference, copyright © 2004 Microsoft Corporation, One Microsoft Way, Redmond, Washington 98052-6399 U.S.A.; all rights reserved.

Note that you must specify a database before you run the script.

/*Perform a 'USE <database name>' to select the database in which to run the script.*/

-- Declare variables
SET NOCOUNT ON
DECLARE @tablename VARCHAR (128)
DECLARE @execstr   VARCHAR (255)
DECLARE @objectid  INT
DECLARE @indexid   INT
DECLARE @frag      DECIMAL
DECLARE @maxfrag   DECIMAL

-- Decide on the maximum fragmentation to allow
SELECT @maxfrag = 30.0

-- Declare cursor
DECLARE tables CURSOR FOR
SELECT TABLE_NAME
FROM INFORMATION_SCHEMA.TABLES
WHERE TABLE_TYPE = 'BASE TABLE'

-- Create the table
CREATE TABLE #fraglist (ObjectName CHAR (255),
ObjectId INT,
IndexName CHAR (255),
IndexId INT,
Lvl INT,
-- Open the cursor
OPEN tables

-- Loop through all the tables in the database
FETCH NEXT
FROM tables
INTO @tablename

WHILE @@FETCH_STATUS = 0
BEGIN
  -- Do the showcontig of all indexes of the table
  INSERT INTO #fraglist
  EXEC ('DBCC SHOWCONTIG (''' + @tablename + ''') WITH FAST, TABLERESULTS, ALL_INDEXES, NO_INFOMSGS')
  FETCH NEXT
  FROM tables
  INTO @tablename
END

-- Close and deallocate the cursor
CLOSE tables
DEALLOCATE tables

-- Declare cursor for list of indexes to be defragged
DECLARE indexes CURSOR FOR
  SELECT ObjectName, ObjectId, IndexId, LogicalFrag
  FROM #fraglist
  WHERE LogicalFrag >= @maxfrag
    AND INDEXPROPERTY (ObjectId, IndexName, 'IndexDepth') > 0

-- Open the cursor
OPEN indexes
Customizations

Customizations to Infor ERP SyteLine should be evaluated for performance along with standard product components. You should ensure that indexes for new tables are designed correctly and maintained adequately. If a custom feature performs slower than when it was first implemented, determine whether unneeded records are causing the performance reduction.

Custom reports and processes should be evaluated to see if they are reading the least number of records. BI queries should be similarly evaluated for efficiency.

User Actions

End users’ practices can slow Infor ERP SyteLine performance. Actions such as querying an unlimited number of records into a form, specifying overly broad query criteria in reports, and running unneeded reports increase network traffic and can tax database resources.
Reduce the Number of Rows Returned in Queries

In WinStudio, users can choose to retrieve all rows or any specified maximum number of rows in queries. This option overrides a default limit set on queries that return data records and items in drop-down lists. However, unlimited queries can degrade system performance or exceed the resources of the utility server and the client machine.

The process default WinStudio Max Record Cap allows you to set a systemwide limit on the number of records or drop-down list items that users can query into forms. The limit overrides any setting made by the user in WinStudio. See the Help for the Process Defaults form.

Reduce the Scope of Reports

Report users should be sure to set criteria in a such way that the system returns only the information needed for the purposes of the report. Users should limit the range of time frames and other criteria to prevent needless processing.

Users should avoid running unnecessary reports.

Replication

Configure Multi-site Replication with a Master Site and Shared Tables

Set up an intranet with a master site and share certain _all tables. This allows other sites to use views into shared _all tables on the master site, reducing replication traffic between the sites. Advantages and requirements are described in the Multi-Site Planning Guide. The process is described in the Multi-Site Implementation Guide.

Locking and Blocking

Locking prevents users from reading data being changed by other users, and prevents multiple users from changing the same data at the same time. If locking is not used, data within the database may become logically incorrect, and queries executed against that data may produce unexpected results. SQL Server enforces locking automatically. Locking can occur at record, page, or table level.

Blocking occurs when one user holds a lock and a second user requires a conflicting lock type. This forces the second user to wait, blocked by the first. Typically, the second user sees an hourglass while trying to process or save records. Most blocking problems happen because a single process holds locks for an extended period of time, causing a chain of blocked processes. A design goal is to minimize the amount of time a record is locked to reduce the potential blocking of another user.

A deadlock arises when two processes have data locked, and each process cannot release its lock until the other process has released its lock. SQL Server rolls back one of the transactions and then allows the other transaction to continue.
Monitor Blocking

The utility **SyteLine SQL Performance Log** allows you to monitor blocking and to log the results. Download the utility from the support site http://www.infor365.com/. Navigate to the Infor ERP SyteLine Knowledgebase and select the Solution By Solution ID option. The Solution ID is 2003SyteLine33733.

Save Each Modified Row in a Separate Transaction

You can specify that WinStudio save each modified row in a separate transaction. By default, without this setting, all modified rows are sent to the mid-tier to be processed within a single transaction.

Saving one row per transaction can alleviate blocking problems in some forms. Whether the setting enhances performance depends on the complexity of a form’s save operation and the speed of the network connection. Forms that require highly complex saves may benefit from the setting, especially if connection speed is adequate. Forms that require simple save operations are less likely to benefit, especially if the additional network traffic required in saving one row at a time slows the system.

In default WinStudio behavior, if one row fails, the entire transaction is rolled back. When you save each row in a separate transaction and a row fails, all previous rows remain committed.

**NOTE:** If your form design requires that all modified rows be committed as a unit, with processing on the unit before and/or after a save operation, saving rows in separate transactions may not be appropriate. If an error occurs on a row, some rows may be committed and others not committed.

The following forms save rows in separate transactions:

- Job Orders
- Customer
- Vendor
- Item
- Job Operations
- Job Materials
- Current Operations
- Current Materials
- Purchase Orders
- Purchase Order Lines
- Customer Orders
- Customer Order Lines

For instructions on setting this feature, see "Save One Row Per Transaction" in the Help for WinStudio edit mode.
Set the Collection Read Mode (Transaction Isolation Level)

You can specify whether form queries read committed or uncommitted data by setting the Collection Read Mode. The setting applies to queries that load primary collections, secondary collections, and lists, and to in-collection validations. It also applies to background-task queries that generate reports and to background-task stored procedures. The setting does not affect SQL SELECT operations or other processing coded in stored procedure (method) calls. The default Collection Read Mode, UNCOMMITTED, corresponds to the Transact-SQL statement SET TRANSACTION ISOLATION LEVEL READ UNCOMMITTED.

With the UNCOMMITTED setting, which allows the reading of uncommitted data, users do not have to wait for other long-running transactions that access the same dataset to complete before their queries can complete.

With the COMMITTED setting, a query reads committed data and returns only data for which the query can get a shared lock.

The base, systemwide transaction isolation level is set on the Process Defaults form. Note that if this setting is unsuitable for all forms and tasks, you can override it for selected forms and tasks. You can set the isolation level for individual reports and stored procedures on the Background Task Definitions form. You can also override the system setting at the form level in WinStudio edit mode. See "Set the Read Mode for a Collection" in the Help for WinStudio edit mode and "Setting Transaction Isolation Levels" in the Help for Infor ERP SyteLine.

Prevent Locking of the Journal Table During Mass Journal Posting

Posting a large number of transactions with the Mass Journal Posting form can set an exclusive lock on the journal table. This prevents users from inserting data into the table until the posting is complete.

The process default Journal Posting - No Table Locks allows you to override this behavior. The value 1 prevents an exclusive table lock from being taken during mass journal posting. The value 0 does not prevent a lock. The setting applies to both forms and the background task that runs journal posting without middleware. See the Help for the Process Defaults form for more information.

Prevent Blocking of Other Processes When Rolling Current Costs to Standard Costs

Normally, the Roll Current Cost to Standard Cost utility processes all current costing data at one time. When processing large amounts of data, this can block other processes, such as adding jobs, adding CO lines, using the Purchase Order Receiving form, or opening the Customer Order Lines form.

The process default Roll Current to Standard - No Table Locks allows you to override this behavior. Changing this setting from 0 (the default) to 1 can eliminate this blocking. You should understand, however, that selecting this option can also slow down the Roll Current Cost to Standard Cost utility processing.
Prevent Deadlocks on the Item Table During Certain Operations

Deadlocks on the item table can occur during certain operations involving bills of materials that contain many items. The Lock Job Items process default determines whether job items are locked during these operations. With the value 1, operations such as releasing a job, which copies the bill of materials, and posting a job will lock all item records in blocks according to the operation number. The default value, 0, does not lock item records. See the Help for the Process Defaults form.

Avoid Long Delays from Deadlocks

A high value for the process default Number of Deadlock Retry Attempts can cause users to experience excessive delays from deadlocks. The value 3 is a recommended starting point. See the Help for the Process Defaults form.

Windows Tools

- Memory - Use Perfmon to determine memory usage and to determine if expansion is needed. If additional memory is used as AWE memory, verify in the SQL Server error log that the statement "Address Windowing Extensions enabled" exists.

SQL Server Stored Procedures and Commands

The items in this section can be used to return information related to performance.

- sp_who and sp_who2 - The stored procedure sp_who shows what SPID is blocked; sp_who2 shows who is blocking.
- sp_helpindex (table_name) - Gives index information on a table.
- DBCC OPENTRAN - Determines whether an open transaction exists within the log.
- DBCC INPUTBUFFER (SPID) - Displays the last statement sent from a client to SQL Server.
- DBCC Trace On - Enables specified trace flags.

Troubleshoot Timeout Errors

If you receive timeout errors when executing long-running processes, use this section as a troubleshooting guide. The items listed are listed in the order you should check them. It’s a good idea to keep track of the original settings so you can change them back if you like.

1. Configuration Manager - On the Utility Server select Start>All Programs>Infor>Tools>Configuration Manager. Select the configuration and click the Edit button. For the application database, ensure ‘Query Timeout’ is set to 0 to make the timeout unlimited.
2. **SQL Server** - On the SQL Server (database server), open SQL Management Studio and log in. Right-click on your SQL Server and select **Properties**. Click **Advanced**. Set the value of **Query Wait** to 0 to make the timeout unlimited.

3. **MSDTC** - On the Utility Server select **Start>All Programs>Administrative Tools>Component Services**. Expand until you find My Computer. Right-click on My Computer and select **Properties**. Click the **Options** tab and set Transaction Timeout value to 0.

4. **httpRuntime executionTimeout**. This setting is located within the web.config file on the utility server where IIS is running. Find web.config here - C:\Inetpub\wwwroot\IDORequestService. This file is delivered with SyteLine. The maximum is 7800. Open the file and look for the following:

```
<httpRuntime executionTimeout="number"
maxRequestLength="16384"/>
```

Change **number** to 7800.

5. **machineSettings maxTimeout** - This setting is located within the machine.config file on the utility server. Find this file here - C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\CONFIG. Infor does NOT distribute this file as part of SyteLine. Change this setting to 2 hours. To do this, make an entry in the machine.config file.

In the machine.config file, find: `</configuration>` and just inside of it (to the left of it) add the following:

```
<system.transactions>
  <defaultSettings distributedTransactionManagerName=""
timeout="02:00:00"/>
  <machineSettings maxTimeout="02:00:00"/>
</system.transactions>
```
NOTE: For more information about the forms listed in this section, refer to the online help.

When populating an empty database, it is recommended that you enter the following information on the following forms in the following order:

**Step 1: Users**
Use this form to register users to the application. A user ID is required for each user who logs on to the application.

**Step 2: Object Authorizations for User**
Use this form to set up form-level security for a user or to set up security for a user based on a middle-tier IDO.

**Step 3: Chart of Accounts**
Use the Chart of Accounts form to define account numbers which will be used throughout the system to record, track, and report costs. The General Ledger is tied to other parts of the system through the Chart of Accounts and the journals.

**Step 4: Accounting Periods**
Use the Accounting Periods form to maintain the accounting periods used by General Ledger.

**Step 5: Bank Reconciliations**
Infor ERP SyteLine maintains a transaction history of all activity against the bank checking accounts your company uses. You can view this information through the Bank Reconciliations form, and also prepare bank reconciliations by tracking what has been recorded by the bank.

**Step 6: Financial Statement Definition**
You can define your own financial statements that best suit your reporting needs. Using the Financial Statement Definition form, you can add new financial statements. You then use the Financial Statement Definition Columns and Financial Statement Line Definition forms to define the content and format of a given statement.

**Step 7: Financial Statement Definition - Columns**
See “Financial Statement Definition in the previous step.”
**Step 8: Financial Statement Line Definition:**
See “Financial Statement Definition two steps prior to this one.

**Step 9: General Parameters**
Use the General Parameters form to set the parameters used throughout the system.

**Step 10: Shop Floor Control Parameters**
Use the Shop Floor Control Parameters form to set up default settings for shop floor data and for running the Scheduler.

**Step 11: Order Entry Parameters**
Use the Order Entry Parameters form to set default values for customer order entry.

**Step 12: Inventory Parameters**
Use the Inventory Parameters form to set parameters in your inventory system for use throughout the entire system. Changing these parameters can affect the way the system is run and how it handles inventory.

**Step 13: Planning Parameters**
Use the Planning Parameters form to enable features and options used throughout the MRP and APS planning functions.

**Step 14: Purchasing Parameters**
Use the Purchasing Parameters form to enter default values for use throughout Purchasing.

**Step 15: Accounts Payable Parameters**
Use the Accounts Payable Parameters form to specify the accounts to use in the General Ledger. These accounts are used throughout A/P for distributions to the G/L.

**Step 16: Accounts Receivable Parameters**
Use the Accounts Receivable Parameters form to enter the default parameter values the system applies throughout Accounts Receivable.

**Step 17: Departments**
Use the Departments form to maintain a list of all departments referenced by work center and employee records. The Department field also appears on the Fixed Assets Class Codes form. You use departments to group work centers for application of overhead rates and direct labor cost. To report departmental shop floor capacity, combine all work centers of the department.

**Step 18: Product Codes**
Use product codes to group similar types of items and assign each group an identifying code. Product codes can override system-wide parameters for a subset of items.
Step 19: Distribution Accounts
Distribution accounts are a set of accounts grouped by Warehouse and Product Code.

Step 20: Tax Codes
Use the Tax Codes form to specify the percentage of tax to charge to a customer and the G/L Account to which the sales tax is to be posted.

Step 21: Tax Systems
Use the Tax Systems form to establish the tax system and Tax Codes used in processing Value Added Tax or sales tax related information. The Value Added Tax function processes items in Customer Order Entry, Purchasing, Accounts Receivable, and Accounts Payable.

Step 22: Tax Parameters
Use the Tax Parameters form to define global (applying to both tax systems) switches and dates, and to set optional tax data printing options.

Step 23: Prov/States
Use the Prov/States form to enter state or province abbreviations.

Step 24: Billing Terms
Use the Billing Terms form to identify and maintain billing terms to be applied to customers. The Billing Terms code displays on the Customers and Vendors forms. You can identify default billing terms for each customer or vendor.

Step 25: Miscellaneous Receipt Reason Codes
Use the Miscellaneous Receipt Reason Codes form to track the entry of Miscellaneous Receipt transactions. For example, you could use the code RTS to indicate a return to stock.

Step 26: Miscellaneous Issues Reason Codes
Use the Miscellaneous Issues Reason Codes form to track the entry of Miscellaneous Issue transactions. For example, you could use the code TES to indicate the material was issued for testing.

Step 27: Locations
Use the Locations form to maintain the list of valid places for inventory. These locations are used when establishing inventory balances and processing inventory transactions. The system initially creates a location of Stock and strongly recommends that you not delete this record, since several Infor ERP SyteLine programs assume that Stock exists as a default.

Step 28: Unit of Measure Codes
Use the Unit of Measure Codes form to maintain all units of measure that can be associated with an item. Transactions can then be tracked in various units. A base unit of measure is assigned to each item on the Items form.
Step 29: Shift Codes

Use the Shift Codes form to maintain codes that identify particular shifts for use in payroll administration. You can create as many shifts as needed based on the starting and ending times for a flex-time work schedule. Use the Scheduling Shifts form to define shifts to schedule resources for working on operations.
Database Name Change

If for any reason you have changed the name of your application database, you must also change pointers in the system to that new database name.

There are two forms which have pointers to the database name:

- **Planning Parameters** - On the Sites tab, change the SQL Database Name field to the new name.
- **Sites/Entities** - On the System Info tab, change the Database Name field to the new name.
Web Rendering Differences

This appendix lists the differences in behavior between the standard WinStudio Smart Client and the Web Client. Subsequent releases will reduce this list.

NOTE: If you use the Web Client with Internet Explorer 8, you must clear the Display internet sites in Compatibility View field found on the Tools>Compatibility View Settings dialog in Internet Explorer.

Runtime Options

The following functions in the menus listed below are not available in web rendering:

From the Form menu
- Page setup
- Print preview
- Print
- Export to File
- Workspaces

From the Actions menu
- To Excel

From the View menu
Some of the items on the view menu listed below are visible, but the behave differently than they do in a regular client.
- Explorer
- Diagnostics
- Inbox
- Task List
- Status bar
- System Notes
- Activate Next Collection
**Home Cursor**

**Hide/Show Splitter Pane 1 (and 2)**

**Activate Pane 1 (and 2)**

**Warnings**

### Window menu

There is no window menu.

### Non-supported items

- Internet Explorer 7 is not supported. For a list of supported browsers, see the "Requirements" section of Chapter 2, "Setting up the Utility Server" in the *Infor ERP SyteLine Installation Guide*.
- Numeric fields (example: Check Number in AP Payments) behave differently. Some of the dynamic behaviors for numerically-masked fields are not implemented in the web client and instead are implemented after you tab out of the field.
- The Alerts, Tasks, and Inbox options on the Home pages are not supported.
- The Communication Wizard (for Customers, Sales Contact Groups, and Campaigns) is not supported.
- The following forms do not display in web client: Web Browser, Plan Detail, Resource Gantt Chart, Resource Gantt Chart APS, Demand Detail APS, Export Routing BOM, User Calendar, and Calculator.
- Design mode is not supported.
- Images dynamically applied to individual cells within grids are not supported.
- Multi-row select in grids is not supported.
- Sending e-mails using Outlook Client is not supported.
- Auto-insert (*) row in grids is not supported.
- The following SyteLine forms are not currently supported in the web client: Replication Document Inbox and Replication Document Outbox.

### Items supported beginning with version 8.02.11.

- Uploading and downloading of binary properties and presentation of binary properties as images. However, SyteLine forms that present binary properties as images still have those images hidden until you get updated versions of those forms. Until you get the updated forms, for example, on the License Management form, you cannot browse to a license file. You must paste in the contents of the file. Also, in the web, browsing to files is routed through upload/download browser functionality, and the behavior varies somewhat from the way it works in windows, and between browsers.
- Color and font applied to individual cells within grids.
- Base font for forms specified in View>Settings is honored.
- Execution of form event handler, with Response Type of "Goto URL" and Response evaluating to a UNC path. However, you must get updated versions of the Notes forms to take advantage of this feature.
- Copy to and from clipboard.
The Diagram component type when you get updated versions of the Home forms.

- All of the tree scripting APIs listed as previously not implemented in the Web Client have now been implemented (including colors, fonts, and images).
- The Edit Grid Column dialog is now displayed when the event StdCurCompEditGridColumn is generated, as in the WinStudio client.

Form Component Types

**UserControl**

The winforms UserControl assemblies currently provided do not run in web rendering. However, you can make a UserControl component work in both winforms and web rendering by retaining the winforms assembly and specifying a web assembly and URL. The web assembly contains a non-winforms class derived from our WSUserControlBase class or by implementing the interface. This implements the server-side communications between the WinStudio runtime and your code.

You can write a web page which communicates with our web browser infrastructure via a javascript API which includes the ability to post requests back to WinStudioRuntime as well as to receive messages from the WinStudioRuntime in the browser.

The web assembly gets deployed on the web rendering web server. The web content can then be deployed wherever you wish.

WinStudio Diagnostics

For web rendering, there is no client support for WinStudio Diagnostics. However, if you need to use this capability on the web/utility server, follow these steps:

1. On the web/utility server for the Web Client, edit the user preferences .xml file, which is found here - c:\ProgramData\Mongoose. ProgramData is a hidden folder, so you will have to unhide it to see it. The name of the user preferences .xml file follows this naming syntax "<application name>Prefs<sytelineusername>.xml". For example, if the SyteLine user is "myuser", the file is named Infor ERP SLPrefsmyuser.xml.

2. Find the section in the .xml file for diagnostics, and enable the settings you want by changing the value of the tags from a 1 to a 0.

3. Run LogMonitor.exe (Start>All Programs>Infor>Tools>Log Monitor).

   Now if you log in as that user on a configuration for that application, you will see the WinStudio diagnostics in Log Monitor.

Event Handler Response Types

- **Timer** - not supported
- **BinaryValueAction** - supported beginning with 8.02.11
RunExe - not supported

Opening a Second Session in Internet Explorer

If you are using Internet Explorer 8 as your browser and you want to open a second session, you must select File>**New Session** in Internet Explorer.

Other Non-Supported Items

SytePlan

- S&OP Workbench is not supported.

Forecasting

- The Forecast Sales Analysis form is not supported.
Workbench Suite

There are a handful of notable differences regarding Workbench Suite behavior when comparing the Web Client to the Smart Client. Critical Number Gauges behave the same in the Web Client as they do on the Smart Client with the exception of right-click display settings support and the thermometer style gauge. The DataView Results Grid have a slightly more noticeable reduction in features as listed in the table below. Over time it is expected that the difference between the two means of access will decrease as the Web Client is enhanced to support more advanced features.

<table>
<thead>
<tr>
<th>DataView Features</th>
<th>Smart Client</th>
<th>Web Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Grouping</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Column Summaries</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Simple Filtering</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Quick Refresh</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Quick Setup</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Layout Selection</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Right-click Drill-in Details</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Column Management (Scroll Lock, Arrangement, Selection)</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Custom Calculated Column Setup &amp; Access</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Advanced (Excel Style) Filtering</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Layout Maintenance</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Results Printing</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>“Send To” Functionality (PDF and Excel)</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

FS-Plus

When FS-Plus is run on the Web Client, the subsets of features that are not available are as follows:

- **Scheduling Board** - The advanced functionality of the interactive scheduling board does not lend itself well for deployment over the Web. As scheduling and dispatch are considered back office tasks, they will be limited to the Smart Client deployment.

- **MapPoint Integration** - Due to potential security risks and filter permission complications, MapPoint will only be available on the Smart Client.
You can change the look and behavior of your Web Client by editing the settings of the web.config file using IIS.

1. Open IIS Manager on the utility server.
2. Browse to the WSWebClient site.
3. Open the Application Settings dialog for WSWebClient.
4. You can change the value for defaultUIMode and defaultWorkstationLogon.
   - **defaultUIMode** - The options are iux and classic. What you set here determines the default interface you see; iux provides the standard Infor look and feel; classic provides the traditional SyteLine look and feel.
   - **defaultWorkstationLogon** - The options here are true and false. If set to true, the sign in dialog box displays with the "Use Workstation Login" checkbox selected. If the value is set to false, the "Use Workstation Login" checkbox is cleared.
Index

A
Admin Client 15
Application Database 14
Audit Log 149, 151
  Setting Up 149
Audit Log Types 150
Authorizations 49

B
Background Tasks 19
  Background Task Definitions 24
  Background Task History 24
  Create 24
  Delete a Waiting Task 23
  Executable Programs 24
  Reports 23, 24
  Stored Procedures 24
  Utilities 23
  View Running Tasks 23

C
Client 15
COM+ 16
Contacting Infor 10
Crystal Reports
  Default Output and Preview Formats 22
  E-mail Notification 21
  Error and Output File Names 20
  Error Log 20
  Generating through Task Manager 20
  Labels not Displaying Properly 26
  Output Files 20
  Output Format 22
  Printer Name 22
  RPT Files 20
  Strings Table to Use 21
  Troubleshooting 26
  URL Path 22

D
Data Collection
  Multiple Logins 45
Debug Parameters, in Task Manager 29
Download
  Infor documentation 7

E
E-mail Notification
  in Report Options 22
  on Intranets Form 21
Empty Database
  Populate 167
End-User 15
Event Messages from Task Manager 27

Excluded Tasks, Defining 22

F
Form-Level Security 49
Forms Database 14
Forms Security 55

G
General Parameters Form 26
Get Options 25
Group
  Accounts Payable 59
  Accounts Receivable 61
  Advanced Manufacturing 64
  APS - Override Projected Date 66
  APS - Set Due Date 67
  Credit Field Update 67
  Data Collection 67
  Data Collection Hide Costs 69
  Data Collection IDO 69
  Delivery Orders 71
  Delivery Orders Hide Prices 71
  Electronic Data Interchange 74
  Electronic Data Interchange Hide Costs 76
  Employee Hourly 76
  Employee Salaried 76
  Engineering Change Notices 72
  Engineering Change Notices Approve 72
  Engineering Change Notices Est Delete 73
  Engineering Change Notices Est Insert 73
  Engineering Change Notices Est Update 73
  Engineering Change Notices Est View Costs 73
  Engineering Change Notices Hide Costs 74
  Engineering Change Notices Job Delete 73
  Engineering Change Notices Job Insert 73
  Engineering Change Notices Job Update 73
  Engineering Change Notices Job View Costs 73
  Engineering Change Notices Post 73
  Engineering Change Notices Std Delete 73
  Engineering Change Notices Std Insert 73
  Engineering Change Notices Std Update 73
  Engineering Change Notices Std View Costs 73
  Enter Out Of Date Range 76
  Entity Forms 77
  ERPConfiguration 80
  Estimating 80
  Estimating Hide Costs 81
  Estimating Hide Prices 81
  Fixed Assets 82
  General Ledger 83
  Goods Receiving Notes 85
  Human Resources 86
  Human Resources Hide Costs 90
  Internal System Users 91
Index

<table>
<thead>
<tr>
<th>Inventory</th>
<th>92</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Costs Maintenance</td>
<td>99</td>
</tr>
<tr>
<td>Inventory Hide Costs</td>
<td>99</td>
</tr>
<tr>
<td>Item Maint - Rev Track</td>
<td>100</td>
</tr>
<tr>
<td>Item Stockroom - Remote Insert</td>
<td>100</td>
</tr>
<tr>
<td>MGR - Accounts Payable</td>
<td>100</td>
</tr>
<tr>
<td>MGR - Accounts Receivable</td>
<td>101</td>
</tr>
<tr>
<td>MGR - Data Collection</td>
<td>101</td>
</tr>
<tr>
<td>MGR - General Ledger</td>
<td>101</td>
</tr>
<tr>
<td>MGR - Human Resources</td>
<td>102</td>
</tr>
<tr>
<td>MGR - Inventory Control</td>
<td>102</td>
</tr>
<tr>
<td>MGR - Order Entry</td>
<td>103</td>
</tr>
<tr>
<td>MGR - Payroll</td>
<td>104</td>
</tr>
<tr>
<td>MGR - Purchasing</td>
<td>104</td>
</tr>
<tr>
<td>MGR - Return Material Authorizations</td>
<td>105</td>
</tr>
<tr>
<td>MGR - Shop Floor Control</td>
<td>105</td>
</tr>
<tr>
<td>Order Entry</td>
<td>105</td>
</tr>
<tr>
<td>Order Entry Hide Costs</td>
<td>114</td>
</tr>
<tr>
<td>Order Entry Hide Prices</td>
<td>114</td>
</tr>
<tr>
<td>Payroll</td>
<td>116</td>
</tr>
<tr>
<td>Payroll Hide Costs</td>
<td>117</td>
</tr>
<tr>
<td>Posting Out Of Current Period</td>
<td>117</td>
</tr>
<tr>
<td>Project Adjustment Transaction</td>
<td>118</td>
</tr>
<tr>
<td>Project Cost Rollup</td>
<td>118</td>
</tr>
<tr>
<td>Project Entry</td>
<td>118</td>
</tr>
<tr>
<td>Project Estimating</td>
<td>118</td>
</tr>
<tr>
<td>Project Labor Transaction</td>
<td>118</td>
</tr>
<tr>
<td>Project Manager</td>
<td>118</td>
</tr>
<tr>
<td>Project Material Transaction</td>
<td>118</td>
</tr>
<tr>
<td>Projects</td>
<td>118</td>
</tr>
<tr>
<td>Projects Hide Costs</td>
<td>121</td>
</tr>
<tr>
<td>Purchase Requisitions</td>
<td>122</td>
</tr>
<tr>
<td>Purchase Requisitions Approval</td>
<td>123</td>
</tr>
<tr>
<td>Purchase Requisitions Hide Costs</td>
<td>122</td>
</tr>
<tr>
<td>Purchasing</td>
<td>123</td>
</tr>
<tr>
<td>Purchasing Hide Costs</td>
<td>127</td>
</tr>
<tr>
<td>Return Material Authorizations</td>
<td>128</td>
</tr>
<tr>
<td>Return Material Authorizations Hide Costs</td>
<td>129</td>
</tr>
<tr>
<td>Shop Floor Control</td>
<td>129</td>
</tr>
<tr>
<td>Shop Floor Control Hide Costs</td>
<td>135</td>
</tr>
<tr>
<td>Standard Forms</td>
<td>135</td>
</tr>
<tr>
<td>Systems Administration</td>
<td>136</td>
</tr>
<tr>
<td>Web-Based DC Transaction</td>
<td>69</td>
</tr>
<tr>
<td>Group Authorizations</td>
<td>54</td>
</tr>
<tr>
<td>View</td>
<td>54</td>
</tr>
<tr>
<td>Group Lists</td>
<td>58</td>
</tr>
<tr>
<td>Groups</td>
<td>52</td>
</tr>
<tr>
<td>Assign Users To</td>
<td>52</td>
</tr>
<tr>
<td>Create</td>
<td>52</td>
</tr>
</tbody>
</table>

| Intelligent Data Objects | 16 |
| Intranets | |
| Polling Interval | 19, 21 |
| Use with Reports | 21 |

| L |
| Launching Applications through Task Manager | 19 |
| License Document | 39 |
| License Management | 39 |
| Apply A License | 41 |
| License Document | 41 |
| License Management Form | 40 |
| Licensed Modules Form | 44 |
| Multi-Session Users | 41 |
| User Modules Form | 44 |

| M |
| Maximum Concurrent Processes | 21 |
| Multiple Logins | 45 |
| Multi-Session Users | 43 |
| Multi-Site | 47 |
| Non Transactional | 47 |
| Output File Names | 20 |
| Transactional | 47 |

| N |
| Nowait Keyword for Task Manager | 30 |

| O |
| Object Authorization for Group | 50 |
| Object Authorizations For User | 49 |
| Objects Database | 15 |
| Online Help | 7 |
| Options Defaults | 25 |

| P |
| Passwords | 55 |
| Change | 55 |
| Polling Interval | 19, 21 |
| Populating An Empty Database | 167 |
| Prerequisites | 9 |
| Preview. See Report Preview |
| Printer Name, Specifying for Reports or Users | 22 |
| Printers, Configuring for Use with Task Manager | 21 |
| Process Defaults | 149 |

| R |
| Recover Locked Tokens | 46, 148 |
| Recovering After a System Crash | 145, 171 |
| Report Options | 22 |
| Report Preview | |
| Default Format | 22 |
| Troubleshooting | 23 |
| Report URL | 22 |
| Reports. See Crystal Reports |
| RPT Files, Placement of | 20 |
| RunCrystal.exe, Placement on Server | 20 |

Infor ERP SyteLine Installation Guide
Copyright © 2011 Infor
Security 49
  Form-Level 49
  User 49
    Middle-Tier IDO 49
Session Management 46, 148
Setting up an Audit Log 149
Sites/Entities
  Strings Table 21
Sites/Entities Form 26
SQL Server 14
Store Options 25
Stored Procedure, Executing through Task Manager 19
Strings Table 38
  Troubleshooting 26
  Used with Reports 21
Super User 53
  Create 53
support
  contacting Infor 10
  signing up for 11
System Architecture 13
System Crash 145
  Recover After 145

T
Task Manager 19
  Configuring Printers 21
  Debug Mode and Messages 29
  Error and Output File Names 20
  Event Messages 27
  Fields on Intranets Form 21
  Installation 20
  Maximum Concurrent Processes 21
  Path 22
  Polling Interval 21
  Setting Up as Service 21
  Timeout Values 21
  See also Background Tasks
  TaskMan.exe, Placement on Server 20
  Terminal Server 17
    Description 17
    Timeouts 21
    Timeout errors 165
  TMConfig.exe, Placement on Server 20

U
Unlock Functions and Journals 146
Unlock Locked Functions 146
Unlock Locked Journals 147
User
  Assign To Group 53
  Assign To Primary Group 53
  Edit Group Authorizations 54
User Information 55
Users 51
  Register 51